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and consumables. This document is copyright protected and any reproduction of this document, in whole or

any part, is strictly prohibited, except as Molecular Devices may authorize in writing.

Software that may be described in this document is furnished under a non-transferrable license. It is against

the law to copy, modify, or distribute the software on any medium, except as specifically allowed in the
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reverse engineered, or decompiled for any purpose.

Portions of this document may make reference to other manufacturers and/or their products, which may

contain parts whose names are registered as trademarks and/or function as trademarks of their respective

owners. Any such usage is intended only to designate those manufacturers’ products as supplied by

Molecular Devices for incorporation into its equipment and does not imply any right and/or license to use or

permit others to use such manufacturers’ and/or their product names as trademarks.

Each product is shipped with documentation stating specifications and other technical information. Molecular

Devices products are warranted to meet the stated specifications. Molecular Devices makes no other

warranties or representations express or implied, including but not limited to, the fitness of this product for

any particular purpose and assumes no responsibility or contingent liability, including indirect or

consequential damages, for any use to which the purchaser may put the equipment described herein, or for

any adverse circumstances arising therefrom. The sole obligation of Molecular Devices and the customer's

sole remedy are limited to repair or replacement of the product in the event that the product fails to do as

warranted.

For research use only. Not for use in diagnostic procedures.

The trademarks mentioned herein are the property of Molecular Devices, LLC or their respective owners. These trademarks may not be used

in any type of promotion or advertising without the prior written permission of Molecular Devices, LLC.

Patents: http://www.moleculardevices.com/patents

Product manufactured by Molecular Devices, LLC.

3860 N. First Street, San Jose, California, 95134, United States of America.

Molecular Devices, LLC is ISO 9001 registered.

©2024 Molecular Devices, LLC.

All rights reserved.

http://www.moleculardevices.com/patents


5054791 G 3

Contents

Safety Information 6

Warnings, Cautions, Notes, and Tips 6

Symbols on the Instrument 7

Electrical Safety 9

External or Implanted Medical Device Safety 9

Heat and Burn Safety 9

Chemical and Biological Safety 10

Moving Parts Safety 10

Chapter 1: Introduction 11

Workflows 11

Before You Start 14

Software Installation 15

Powering On the System 19

Powering Off the System and the Software 19

Chapter 2: Instrument Overview 21

Process Area 22

Computer Connections 24

Front Panel Controls and Display 25

Electrical Connections 25

Bottles Connections 26

Compressed Air Supply 26

Microplate Stackers 27

Filters 29

Using Barcodes 29

Camera Alignment 30

Safety Features 30

Chapter 3: Software Overview 31

Main Navigation Screen 31

Menu Options 33

Chapter 4: Picking Processes 35

Prepare for Pick Run 35

Pick Run Process 44

Imaging Run Process 73



ClonePix 2 Mammalian Colony Picker User Guide

4 5054791 G

Review Results Process 75

Chapter 5: Utility Processes 79

Picking Head Management 79

Utility Process 81

Chapter 6: Maintenance and Troubleshooting 83

Doing Preventive Maintenance 83

Changing Pins 84

Cleaning the Instrument 85

Cleaning the System Fluid Supply 86

Cleaning the Head and Pins 87

Cleaning the Wash and Waste Bottles 90

Cleaning the Wash and Waste Tubing 90

Cleaning the Picking Tubing 91

Cleaning the Ethanol Wash Bath 91

Cleaning the Source Plate Imaging Cover 92

Draining the Compressor 92

Moving and Storing the Instrument 94

Commissioning Process 94

Troubleshooting 94

Obtaining Support 96

Appendix A: Technical Specifications 99

Instrument Dimensions 101

Appendix B: Plate Compatibility 103

Plate Holders 103

Lid Lifter Assembly 104

Appendix C: Replacement Parts, Accessories, and Consumables 105

Replacement Parts 105

Accessories and Consumables 105

Reagents and Media 105

Appendix D: Imaging Definitions 107

Appendix E: Guide to Fluorophore Configurations 111

Measuring Fluorescence 111

Example of Fluorescent Statistic Generation 112

Interior Intensity Statistics 112

Exterior Intensity Statistics Calculation 113

Exterior Intensity Statistics 115



5054791 G 5

Appendix F: ClonePix 2 Data Viewer Software 117

Software Prerequisites 117

Installing ClonePix 2 Data Viewer Software 117

Licensing ClonePix 2 Data Viewer Software 117

Using ClonePix 2 Data Viewer Software 118



5054791 G 6

Safety Information

Information about the safe use of the instrument from Molecular Devices includes an
understanding of the user-attention statements in this guide, the safety labels on the
instrument, precautions to follow before you operate the instrument, and precautions to follow
while you operate the instrument.

Make sure that everyone involved with the operation of the instrument has:

Received instruction in general safety practices for laboratories.
Received instruction in specific safety practices for the instrument.
Read and understood all Safety Data Sheets (SDS) for all materials being used.

Read and observe all warnings, cautions, and instructions. The most important key to safety is
to operate the instrument with care.

WARNING! If the instrument is used in a manner not specified by Molecular Devices,
the protection provided by the equipment might be impaired.

Warnings, Cautions, Notes, and Tips

All warning symbols in the user guide are framed within a yellow triangle. An exclamation mark
is used for most warnings. Other symbols can warn of other types of hazards such as biohazard,
electrical, or laser safety warnings as are described in the text of the warning.

When warnings and cautions are displayed in this guide, be careful to follow the specific safety
information related to them.

The following user-attention statements can be displayed in the text of Molecular Devices user
documentation. Each statement implies a particular amount of observation or recommended
procedure as described:

WARNING! A warning indicates a situation or operation that could cause personal
injury if precautions are not followed. The warning symbol can vary depending on the
warning. The definition of the symbol is included in the text of the warning.

CAUTION! A caution indicates a situation or operation that could cause damage to the
instrument or loss of data if correct procedures are not followed.

Note: A note calls attention to significant information.

Tip: A tip provides useful information or a shortcut but is not essential to the completion
of a procedure.

2
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Symbols on the Instrument

Each safety label on the instrument contains an alert symbol that indicates a type of potential
safety hazard.

Symbol Indication

Indicates a warning for a situation or operation that could cause personal

injury if precautions are not followed. There are specific details written

next to the warning symbol.

Potential electrical-shock hazard from a high-voltage source. All safety

instructions must be read and understood before proceeding with the

installation, maintenance, and servicing of all modules. Power off the

instrument and disconnect the power cord before you do maintenance

procedures that require removal of a panel or cover or disassembly of an

interior instrument component.

Potential lifting hazard. For information about the weight of the

instrument,

Potential pinch hazard.

Potential heat hazard.

Rotating parts hazard.

Power on. See Powering On the System on page 19.

Power off. See Powering Off the System and the Software on page 19.

Alternating current.

Direct current.

Location of the protective earth (ground) terminal.

Location of a fuse.
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Symbol Indication

Instrument serial number.

Instrument manufacture date.

CSA certification.

European technology conformity.

United Kingdom technology conformity.

South Korea technology conformity.

Compliance with Australian radio communication requirements.

Compliance with Chinese RoHS Pollution Control Requirements.

Compliance with the Waste Electrical and Electronic Equipment (WEEE)

Directive of the European Union. You must not discard this electrical or

electronic product or its components in domestic household waste or in

the municipal waste collection system.

For products under the requirement of the WEEE directive, contact your

dealer or local Molecular Devices office for the procedures to facilitate

the proper collection, treatment, recovery, recycling, and safe disposal of

the device.

There is an authorized representative in the European community.

Instrument manufacturer.

Compliance with California Proposition 65, which requires businesses to

warn Californians about significant exposures to chemicals that cause

cancer, birth defects or other reproductive harm.
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Electrical Safety

To prevent electrically related injuries and property damage, inspect all electrical equipment
before use and immediately report all electrical deficiencies. Contact Molecular Devices
Technical Support to service equipment that requires the removal of covers or panels.

The instrument must be connected to a properly grounded power outlet to protect from the risk
of electric shock. The main chassis of the instrument is grounded together with all related
electrical components.

Do not remove the fixed covers, as there are no user-serviceable parts inside. All electrical work
must be referred to Molecular Devices approved service personnel.

In the event of a liquid spillage into the main cavity of the instrument, disconnect the mains
power supply before trying to clean up.

If the external covers on the instrument are removed, the power supply does not automatically
stop.

WARNING! HIGH VOLTAGE Power off the instrument and disconnect the power
cord before you do maintenance procedures that require removal of a panel or cover
or disassembly of an interior instrument component.

Do not try to use the instrument until all covers are replaced.

To provide access for disconnecting power from the instrument, maintain a 66 cm (26 in.)
minimum clearance area on the right side of the instrument.

To protect against fire hazard, replace the fuses only with the same type and rating as the
original factory-installed fuses.

External or Implanted Medical Device Safety

Persons with external or implanted medical devices must evaluate the risks related to these
devices before entering an area where the instrument is in use. Keep magnetic storage devices
or strips, such as hard drives and credit cards, away from the instrument.

Heat and Burn Safety

The instrument is fitted with a high-temperature halogen dryer. The casing can become hot
during the drying cycle.

WARNING! The casing of the halogen dryer can become hot during the drying cycle.
Before touching this area, make sure that the dryer has had time to properly cool to a
safe temperature.
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Chemical and Biological Safety

Normal operation of the instrument can involve the use of materials that are toxic, flammable, or
otherwise biologically harmful. When using such materials, observe the following precautions:

Handle infectious samples based on good laboratory procedures and methods to prevent
the spread of disease.
Observe all cautionary information printed on the original containers of solutions before
their use.
Dispose of all waste solutions based on the waste disposal procedures of your facility.
Operate the instrument in accordance with the instructions outlined in this guide, and take
all the required precautions when using pathological, toxic, or radioactive materials.
Splashing of liquids can occur. When working with potentially hazardous liquids, take
applicable safety precautions, such as wearing safety glasses and protective clothing.
Observe the applicable cautionary procedures as defined by your safety officer when using
hazardous materials.
Observe the applicable cautionary procedures as defined by your safety officer when using
flammable solvents in or near a powered-up instrument.
Observe the applicable cautionary procedures as defined by your safety officer when using
toxic, pathological, or radioactive materials.

WARNING! Never use the instrument in an environment where potentially damaging
liquids or gases are present.

Moving Parts Safety

To prevent injury due to moving parts, observe the following:

Never try to exchange labware, reagents, or tools while the instrument is operating.
Never try to physically restrict the moving components of the instrument.
Keep the interior of the instrument clear to prevent obstruction of the movement.

The motors use high-powered magnets. The linear drive units and encoders are delicate, so be
very careful with them. To prevent serious damage to the instrument or its auxiliary parts, follow
the preparation instructions in this guide before every process.

The instrument door automatically locks whenever you run a process. The door prevents UV
light from passing through during operation.

As a safety measure, if the door is open, an electromagnetic switch prevents the instrument
from running. Never tamper with this switch, as it serves two purposes:

It prevents the motors from running to reduce the potential of physical damage.
It disables the UV light to prevent the risk of damage from UV radiation.

In an emergency, press the Emergency Stop button on the front of the instrument to
immediately stop all motion and turn off the instrument. Before you can restart the instrument,
you must pull out the Emergency Stop button and then press the Start button.

WARNING! Do not obstruct or otherwise prevent access to the Emergency Stop
button.

Motors and their related drives and cabling are sources of electromagnetic fields. Keep
magnetic storage devices or strips, such as hard drives and credit cards, away from the
instrument covers.
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Chapter 1: Introduction

ClonePix™ 2 software controls the process of selective mammalian cell picking by the ClonePix
2 system. The software is designed to simplify the day-to-day interaction with the instrument. It
permits multiple users to select and collect colonies of suspension cells from semi-solid
medium or adherent colonies from liquid medium. The colony detection feature contains
powerful algorithms for selecting cell colonies based on physical characteristics and proprietary
multi-channel fluorescence technology for detecting protein secretion or production.

There are two software packages. ClonePix 2 software is required to run the instrument and
ClonePix 2 Remote Data Viewer is available for purchase to access results remotely. For more
information, contact Molecular Devices Technical Support. See Obtaining Support on page 96.

Workflows

ClonePix 2 software uses three different workflow processes: Pick Run, Batch Run, and Imaging
Run.

Pick Run

The Pick Run processes images and picks the first plate, then the second plate, and so on, from
however many plates you choose.

1
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Batch Run

The Batch Run process is set up within the Pick Run process. This process images all plates in
the stacker cassette and then aggregates statistics for all plates before the picking of the
selected clones from the entire batch.
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Imaging Run

Use the Imaging Run process to observe the status of plates during incubation or to monitor
colony growth and secretion over time. The Imaging Run process images all plates without
picking. After the plates are imaged, you can review the results in ClonePix 2 software or on
another computer using the Remote Data Viewer Software. You can then re-analyze the images
with different statistical criteria.



ClonePix 2 Mammalian Colony Picker User Guide

14 5054791 G

Before You Start

Before you power on the ClonePix™ 2 Mammalian Colony Picker and start the software, do the
following:

Verify that the instrument and compressor are plugged in.
Verify that the correct picking pins are installed in the picking head for the type of cells to
be picked.

Note: Before a Pick Run, picking pins should be cleaned by sonication in a 2%
solution of QuClean (K2505) and autoclaved. Also autoclave the Picking Pin
Removal Key (X4948) at the same time. See Sonicating the Pins on page 90.
If the picking pins need to be changed, remove the Picking Head and swap the pins.
See Picking Head Management on page 79.

Tip: The picking pin type is engraved at the base of each pin. You might need to
remove the pin from the head to confirm the pin type.

Picking pin types include:
F1 Picking Pins (400 µm internal diameter; X4961) for suspension cell picking from
semi-solid medium.

Note: These are the standard pins that come with the instrument.

F2 Picking Pins (700 µm internal diameter; X4962) for adherent cell picking from liquid
medium.

Verify that instrument bed is clear of obstructions and loose items. See Process Area on
page 22.
Verify that all motor tracks are free of obstruction.
Verify that there are no obstructions to movement of the picking head.
Verify that the main instrument axes, XY, are roughly in the center of their respective travel
positions. The axes need to be away from their respective end-stops on startup so that they
can reference themselves correctly to their home positions.
Wipe the instrument bed with 70% ethanol using a lint-free cloth.
Verify that no plates or cassettes are in the stackers.
Verify that the Emergency Stop button on the front panel of the instrument is pulled out.
See Front Panel Controls and Display on page 25.
Fill the ethanol feed bottle with 70% ethanol and empty the ethanol waste bottle, as
needed.
Separately autoclave the picking feed bottle and cap assembly, then fill the Picking Feed
bottle with sterile deionized water and cap the bottle in a sterile tissue culture hood.
Ensure that your picking waste bottle is empty before continuing.
Verify that the enclosure front door is closed.
Wait for approximately 2 minutes after the instrument is powered on before opening the
software to ensure that all drives ‘home’ correctly. See Powering On the System on page 19.

WARNING! For safety reasons the front door interlock should never be interfered with
or overridden. If the door is opened at any stage, this triggers the actuator head or
germicidal lamp to stop until the door is closed.
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Software Installation

Note: Molecular Devices installs the ClonePix 2 software and the software updates.

The ClonePix 2 software controls the ClonePix 2 Mammalian Colony Picker instrument and is
based around the concept of the instrument running processes.

Computer System Requirements

The ClonePix 2 software requires the following computer specifications:

Item Description

Operating system Windows 11

Windows 10, 64-bit

Windows 7, 32-bit

Memory 8 GB RAM or more

Data Connection 10/100 Ethernet port

Camera Connection SBIG: USB 2.0 port

Basler Pylon: USB 3.0 port

Computer System Requirements

CAUTION! Do Not replace the computer operating system with one of your own
computers. The computer supplied with your system includes hardware components
specifically configured to control your instrument.

Backing Up the Previous Version Configuration

Before making any major computer changes, such as installing drivers or software, back up the
current configuration.

Add a Windows System Restore Point

If you are using the Windows 7 operating system, do the following:

1. Open the computer Control Panel, go to System and Security, and then click the System
link.

2. In the left panel, click the System Protection link.
3. In the System Properties dialog, click the System Protection tab and then click Create.
4. In the Create a Restore Point dialog, choose a name that you will remember, such as the

current date or the name of a program you are about to install.
5. When The restore point was created successfully message displays, click Close.
6. In any other dialogs, click Close to finish.

If you use the Windows 10 or 11 operating system, do the following:

1. Open the computer search field, enter CREATE A RESTORE POINT, and select Control panel.
2. In the System Properties dialog, on the System Protection tab, select the main system drive,

and click Create.
3. Enter a description to identify the restore point.
4. Click Create.
5. When the message The restore point was created successfully displays, click Close.
6. In any other dialogs, click Close to finish.
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Back up ClonePix 2 Software Configuration File

To back up your current configuration:

1. Click Start > All Programs > Molecular Devices > ClonePix 2 software > Configuration
Manager.

2. In the Fusion Configuration Manager, click Backup To File.
3. In the Backup Fusion Configuration dialog, enter the version number of the currently

installed software and the date and then click OK.
4. In the Save Configuration File dialog, locate and select the folder where you want to save

the backup file, enter a file name, and then click Save.

Obtaining a License for the Software

The first time that you start the ClonePix 2 software after completing the installation, the
software prompts you for a license.

Requesting a Software License

To request a new software license:

1. In the License Message dialog, click Yes.
2. In the License Request wizard, select Request a New License, and then click Next.
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3. Enter the requested information and click Next.

4. To save the request file to a location on the computer, click Save.

5. In the Save the Request to a File dialog, save the file in a location where you can find it.
6. To close the wizard, click Finish.
7. Change the LicenseRequest.req file name to a LicenseRequest.txt file, and then email it to

Molecular Devices Technical Support. See support.moleculardevices.com/.
8. After you receive the license file, save it on the computer where it is accessible, and then

install the license.

http://www.moleculardevices.com/service-support
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Installing a Software License

After you receive the license from Molecular Devices Technical Support, do the following:

To install a software license:

1. From the computer desktop, double-click the ClonePix 2 icon to start the software.
2. In the Licensing dialog, select Install a License File and click Next.

3. Click Open.

4. In the Select the License File to Install dialog, select the license file you saved and click
Open.

5. After the license file installs, click Finish.
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Powering On the System

Before continuing, do as instructed in Before You Start on page 14.

Every time you use the instrument the three axes sequentially run through their “Initialize
drives” routine. This enables the drives to find their respective home positions. The system must
complete this routine without interference to ensure that there is no damage to the instrument
or its auxiliary equipment.

To power on the system:

1. Power on the compressor and ensure compressed air gauge is set to 80 psi (5.5 bar).
2. On the front panel of the instrument, push the Start button.

The Power On light illuminates.

Tip: If the power to the system does not turn on, make sure that the door is closed
and the Emergency Stop button is pulled out.

The instrument cycles through various start-up processes indicated on the front indicator
panel.

3. Power on the computer and wait for it to finish initializing.
4. From the computer desktop, double-click on the ClonePix 2 icon.

Powering Off the System and the Software

To power off the ClonePix 2 Mammalian Colony Picker:

1. To exit the ClonePix 2 software, on the Main Navigation screen, select File > Exit.
2. To shut down the computer, click Start > Shut down, and then wait for computer to power

off completely.
3. To power off the instrument, on the front of the instrument, press the Stop button.
4. Turn the power off at the mains.
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Chapter 2: Instrument Overview

The ClonePix 2 Mammalian Colony Picker is installed at your site by Molecular Devices.

Before you operate the instrument or do maintenance operations, make sure that you are
familiar with the safety information in this guide. See Safety Information on page 6.

The ClonePix 2 system provides a controlled environment for sample protection conducive to
mammalian cell picking. Protection within the enclosed process bed is provided by a rear
mounted HEPA filtered air supply and a front mounted exhaust fan, which creates a horizontal
laminar flow of sterile air across the picking area of the bed when the front door is closed.

The process area of the instrument contains source and destination stacker lanes, and wash
baths that clean the pins before and during a process. See Process Area on page 22.

Item Description

1 Feed Bottles

2 Front Control Panel

3 Enclosure Front Door

4 Computer Monitor

5 Waste Bottles

ClonePix 2 Mammalian Colony Picker Overview

For information on cleaning the instrument, see Cleaning the Instrument on page 85.

For more information on regular instrument maintenance, see Maintenance and
Troubleshooting on page 83.

For technical specifications, see Technical Specifications on page 99.

2
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Process Area

Item Description

1 Destination Stacker

2 Source Stacker

3 Microplate Lid Lifters

4 Enclosure Front Door

5 Picking Bed and Source Imaging

6 Destination Dispensing Bed

7 Picking Head

8 Picking Pins Wash Station

ClonePix 2 Mammalian Colony Picker Process Area
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Item Description

1 Destination Stacker

2 Source Stacker

3 Microplate Lid Lifters

4 Picking Bed and Source Imaging

5 Destination Dispensing Bed

6 Picking Head

7 Picking Pins Wash Station

ClonePix 2 Mammalian Colony Picker Process Area Close-Up
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Computer Connections

The ClonePix 2 system uses the following computer cable connections:

Item Description

1 Monitor

2 Mouse

3 Keyboard

4 Camera

5 Ethernet

6 Power cable

ClonePix 2 Mammalian Colony Picker Computer Connections

For computer details, see Computer System Requirements on page 15.
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Front Panel Controls and Display

Item Description

1 Feed Tube Connection Ports

2 Stop Button

3 Start Button

4 Activity Status Lights

5 Emergency Stop Button

6 Waste Tube Connection Ports

ClonePix 2 Mammalian Colony Picker Front Panel Controls and Display

Electrical Connections

The ClonePix 2 system uses the following power cable connections:
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Bottles Connections

The ClonePix 2 system uses the following bottle-contained fluid carrying tubing system:

The Picking Feed bottle connection carries sterile water to the Wash Station and back to the
Picking Waste bottle. The Ethanol Feed bottle connection carries ethanol to the Ethanol Wash
Station and back to the Ethanol Waste bottle. The outlets on the instrument are in the same
order as the bottles.

Make sure that the bottles are marked so that the tubes can be re-connected correctly when
you need to refill and empty.

Compressed Air Supply

Compressed air is required for the picking movement of the picking pins and the movement of
the imaging cover. Laboratories with built-in compressed air systems can connect directly to the
filter-regulator inlet on the side of the ClonePix 2 instrument. Alternatively, an optional oil-free
compressed air unit can be connected that draws air from the local environment and delivers it
to the instrument through the filter-regulator inlet and filters it to 0.02 microns using a 3-stage
filtration process.

Item Description

1 Air inlet from house air or optional compressor

2 Air outlet to instrument

ClonePix 2 Mammalian Colony Picker Compressed Air

For the inlet air-pressure requirements, see Technical Specifications on page 99.
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Microplate Stackers

The stacker lanes and cassettes enable the ClonePix 2 Mammalian Colony Picker to run
processes with multiple microplates. The stacker can be used in every process. The stacker
cassettes are tall metal cases designed to hold up to 10 microplates and lid pairs. The source
stacker cassette and destination stacker cassette must always be used together in a lane when
processing microplates and lid pairs. The source stacker cassette is used for automating the
loading of the microplates onto the lane so that they can be automatically moved into the
instrument for colony inoculation. The microplates are automatically collected from the
instrument in the destination stacker cassette after colony inoculation. The lid is removed as the
microplate is pushed through the lid lift mechanism. The lid is replaced as the microplate returns
through to the stacker cassette.

Item Description

1 Lock pin

2 Stacker cassette

3 Microplate Lid Lifter

ClonePix 2 Mammalian Colony Picker Microplate Stacker

Removing a Stacker Cassette

To remove the stacker cassettes:

Pull the lock pin outwards and lift the cassette out of the stacker hole.
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Loading and Installing a Stacker Cassette

To load and install a stacker cassette:

1. With the cassette removed from the instrument, load the microplates with lids on and the A1
well at the front of the slot.

2. Pull the lock pin outwards and lower the cassette into the stacker hole until the lock pin
clicks into place.
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Filters

The ClonePix 2 Mammalian Colony Picker supports the following filter options:

Description Excitation

Wavelength (nm)

Filter

Position

Emission

Wavelength (nm)

Filter

Position

CFP AF430 440 (Royal Blue) 4 505 (Cyan) 4

CloneDetect FITC* Fluorescein

GFP AF488

470 (Blue) 3 535 (Green) 3

YFP 500 (Cyan) 2 550 (Yellow) 2

CloneDetect 549* R-phycoerythrin

Rhodamine AF546

530 (Green) 1 590 (Red) 1

CloneDetect 649* Cy5 FMAT Blue

AF647

622 (Red) 6 700 (Far Red) 6

Note: White light imaging uses excitation filter position 7 and emission filter position 5.

Using Barcodes

If you use barcodes, the following barcode parameters are required:

Use a legible barcode of the following types: 1D (linear) barcodes with code 11, 39, 93 and
128.

Do not use special characters, such as hyphens, in the barcode. Special characters can
cause missed reads and other errors downstream.
Place the barcode centrally on one of the short sides of the plate.

Plate With Barcode

For troubleshooting, see Troubleshooting Barcodes on page 94.
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Camera Alignment

For pin-to-spot accurate picking, you must correctly calibrate and align the camera. The
ClonePix 2 Mammalian Colony Picker camera calibration and alignment is done by Molecular
Devices and verified during on-site installation.

Knocking the actuator can impact picking accuracy. If you need to re-calibrate the camera,
contact Molecular Devices Technical Support support.moleculardevices.com/.

Safety Features

The ClonePix 2 system uses the following safety features:

Enclosure Front Door

The enclosure front door uses an electromagnetic switch that prevents the instrument from
running when the door is open. The door is made of acrylic, which traps UV light in the
instrument.

The electromagnetic switch protects the following:

It prevents the motors from running, which protects against any physical damage.
It disables the UV light, which protects against the risk of damage from UV radiation.

WARNING! Never tamper with the electromagnetic door switch.

UV Light

Inside the process area is a UV germicidal lamp with timer. It is a 30W linear discharge lamp
with a defined output at 253.7 nm to make the lamp an effective source of germicidal radiation.

WARNING! Dispose according to your local regulations.

Emergency Stop Button

Pressing the Emergency Stop button immediately stops the instrument and cuts power from the
drives. The button must be pulled out before the machine can be restarted.

CAUTION! If the computer is powered through the instrument, power to the computer is
also be cut and your current data is not saved.

http://www.moleculardevices.com/service-support
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Chapter 3: Software Overview

The ClonePix 2 software controls the ClonePix2 instrument and is based around the concept of
the instrument running processes. A Process is a standard program for carrying out a task.
Using the default set of processes, you can modify and save them. Processes are managed
from the Main Navigation screen, that displays when the software starts.

Main Navigation Screen

The Main Navigation screen displays when the ClonePix 2 software starts. From this screen, you
select to run processes.

3
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Use the right-click option menu to view the process options as icons or as a list.

The Navigation screen includes the following functionality:

New Process Tab displays the available processes, which are grouped into the following
categories:

ClonePix 2 Processes
Maintenance Processes
Utility Processes

Recent Processes Tab displays a list of recently opened processes. This is the same list of
processes available from the File > Recent Processes menu option.
Interior Light in the status bar at the bottom of the screen, the interior light can be activated
or deactivated at any time by double-clicking the interior light icon.
Open Process button displays the Open dialog where you can select and open a saved
process file. Can also be opened using the File > Open Process menu option.
Login Credentials in the status bar at the bottom of the screen, displays which user-login is
connected, if any.
Connection Status appears in the bottom right corner of the Navigation screen and
displays the status of the Ethernet connection between the computer and the ClonePix
2 system.
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Menu Options

The available options in the menus at the top of the Main Navigation screen change depending
on the screen view and selections.

File Menu

Open Process allows you to open a previously saved process.
Save Process saves the current process.
Save Process As allows you to save the current process with a different name or location.
Close Process closes the current process and returns you to the Process Selection
Window.
Save As Template saves the current process as a template that can be used for creating
new processes.
Recent Processes allows you to select and open a recent process.
Switch User can be used in a multiple user environment to log off the current user so that a
different user can log on.
Exit closes the Navigation window and shuts down the software.

View Menu

Properties displays the properties of the process that is being set before starting the
process.
Progress displays the progress of a running process.
Administrate Properties lets you change the Properties view and default values.

Tools Menu

Configuration displays the Edit Configuration dialog.

CAUTION! We recommend that only trained personnel configure these settings.

Prepare Error Report starts the Error Reporting Wizard to create a data file containing the
configuration and recent log files to help troubleshoot your problem.

Help

About displays the version numbers of the software modules.
Online Support displays the support web page. This option requires an active internet
connection.
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Chapter 4: Picking Processes

Prepare for Pick Run

Run the Prepare for Pick Run process before you run a Pick Run process to ensure that the
system is ready for picking. Any section of the following process can be bypassed by clicking
Next.

Tip: This process is typically run only once a day, before the first pick run.
When multiple pick runs are planned, Prepare for Pick Run is not required before each
picking run.

Click Start to begin the process.

Pin Fire Test

Run the Pin Fire Test to confirm that the pins are firing correctly.

To use Pin Fire Test:

1. Set the speed to fast and click Start.
2. Observe that the pins move freely.
3. Click Stop to end the test.
4. Click Next to move to Alignment on page 36.

4
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CAUTION! If any pin is not firing and retracting freely, do not continue. Run the Pin Fire
Test continually for up to one hour. If this does not free up the pin action, do not
continue. Remove the Picking Head and contact Molecular Devices Technical Support to
arrange for reconditioning. The Picking Head cleaning procedures described in the
General Maintenance section of the Robot User Guide are for sterilization purposes only
and are unlikely to resolve any pin movement issue.

Alignment

Run the Alignment step to align the source plate and the primary pin to the camera.

To use Alignment:

1. Select the source plate type from the drop-down list and click Next.

2. If needed, to raise the source stacker click Raise Source. If the destination stacker is
obstructing access to the source stacker, to lower it, click Lower Destination.

3. Load an empty source plate into the source stacker cassette.

Tip: The empty source plate must be cell-free and media-free. Verify that your
source plate is loaded into the appropriate color-coded plate holder before inserting
into the cassette.

4. Click Next to initiate imaging of the edges of well A1.
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5. If alignment is needed, drag the red lines to line up the well and then click the Re-image
button.

6. Click Next to move to the alignment of the primary pin Z height.

Tip: In normal usage, the Z height of the primary pin should not require adjustment.
Moving onto the next stage without modification is recommended.

If pin height adjustment is required:

1. Click Retract Pin.
2. Open the instrument door and remove the picking tube from the pin 1.
3. Attach the tube from the air pressure gauge to the pin 1.

The air pressure gauge displays a value in red.

4. Turn the pressure gauge to the ON position by twisting the gray knob clockwise so that the
handle is vertical.
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5. Click Go To Source Stacker.

Note: The datum point can be set only with the pin extended.

6. Use the Vertical arrow buttons to lower the pin in small increments until the value on the
pressure gauge turns from red to green.

Tip: To change the move increment, select a new value from the Move Size list.
When the pressure gauge value starts to increase, reduce the move increment.
Record the previous Z datum value for guidance and comparison.

7. Before you set the datum, adjust the Z position so that the pin is just touching the well
bottom using the smallest move increment 0.01 mm, and then back off by 0.01 mm.

8. To set this datum point, click Set, and then when prompted, to save the datum, click Yes.
9. Before you continue, click Retract Pin, turn off the pressure gauge, remove the air pressure

tube from pin 1, and then reconnect the picking tube.
10. To move to alignment of the primary pin X & Y coordinates, click Next.
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To align the pin correctly:

1. Click Go To Source Stacker.

Note: There is no need to choose Stop Short Above as the pin already stops short by
0.5 mm.

2. Use the Lateral jog buttons to move the pin until the pin hole is centered on the red cross.

Tip: Use the Image Zoom slider to zoom in on the image for accurate alignment.

3. When the pin is in the required position, click Set.

Note: If you do not click Set, the new datum point will not be fixed.

4. If the image is not bright enough, increase the Exposure Time or LED Intensity.
5. Click Next to set up for sterilization of the fluid system.

Check Wash Bath

To check the wash bath:

1. Check to see if there is any 70% ethanol in the wash bath.
If the system has not been used, the bath might be empty, fill it in the next stage of the
process.
If the system has been used already, the bath might be filled enough.

2. Click Next.
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Wash Bath Utility

The Wash Bath Utility step allows the Wash Bath to be filled and the Auto Replenish to be set as
required.

To use the Wash Bath Utility:

1. Click Start to fill the Wash Bath.
2. Click Stop when the Wash Bath is filled.
3. Select Auto Replenish Wash Bath to turn on the Auto Replenish function. This keeps the

wash bath filled while the software is running. Change the default timings, if necessary.
4. Click Next.

Sanitize Pins in Sterilant

The Sanitize Pins in sterilant step sanitizes the pump system between the sterile wash bottle
and the picking pins.

Tip: Sanitize the pins at the start of each day. We recommend using Spor-Klenz® Ready-
To-Use Cold Sterilant.

As an alternative, you can use 70% ethanol to sanitize the pins and feed system. See
Alternative: Sanitize Pins in 70% Ethanol on page 41.

CAUTION! Do not leave sterilant in the system for more than an hour.

To use Sanitize Pins with sterilant:

1. Connect a wash bottle containing the freshly prepared sterilant to the wash supply line. For
preparation instructions, see the documentation that came with the sterilant.

2. To pump the sterilant through the entire system, click Start. This takes several minutes. The
sterilant must be left for 10 minutes. This can be done at the same time as UV sterilization.
See Ultra Violet Sanitize on page 41.

3. Click Next.
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Alternative: Sanitize Pins in 70% Ethanol

This alternative sanitize step uses 70% ethanol to sanitize the pump system between the sterile
wash bottle and the picking pins.

Tip: Sanitize the pins at the start of each day.

CAUTION! Do not leave ethanol in the system for more than an hour.

To use Sanitize Pins with 70% ethanol:

1. Prepare a solution (about 1 liter) of 70% ethanol (70% ethanol: 30% deionized water) in a
ClonePix feed bottle.

2. Connect the bottle containing 70% ethanol. Run purge to fill the system. Leave the solution
in the system to disinfect for 20 minutes.

3. Replace the ethanol feed bottle with a feed bottle containing high-quality sterile water,
connect the sterile water bottle and purge to rinse out the ethanol.

4. Click Next.

Ultra Violet Sanitize

The Ultra Violet Sanitize process activates the interior germicidal lamp.

To use Ultra Violet Sanitize:

1. Set the required duration. 10 minutes (600 seconds) is recommended.
2. Click Begin. The lamp turns off after the set time. If the protective door is opened, the lamp

switches off until the door is closed. After the door closes, the duration time resets to 10
minutes and can be activated again.

3. Click Next.
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Check Bottles

The feed system must be purged with sterile water.

To check bottles:

1. Disconnect the fluid supply line from the bottle that contains sanitizing solution (Sterilant or
70% ethanol) and connect to an autoclaved bottle of high-quality sterile water.

2. Empty the waste bottle.
3. To set up purge conditions, click Next .

Tip: The connectors seal automatically when disconnected. As a sanitation precaution,
liberally spray both ends with 70% ethanol before you connect the wash bottle.

Sanitize Pins

To start the Sanitize Pins purge:

1. Click Start to pump sterile water through the entire system. This takes several minutes.

CAUTION! Never bypass sanitize steps. If the system does not need to be sterilized,
it is still essential to remove any air bubbles that have appeared if the system has
been idle for any time, especially overnight. Air in the line can seriously affect
picking success rates.

2. Click Next.

The system parks the head safely, returns the source plate, and closes the illumination cover.
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Finish

To finish:

1. Click Finish to return to the Prepare for Pick Run process Start page.

2. Click Close Process to return to the Main Navigation screen. See Main Navigation Screen
on page 31.
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Pick Run Process

The Pick Run process includes default parameters required for a full imaging and picking run,
which involves image acquisition, colony detection, group selection, and automated picking.
Use the Pick Run process to create multiple user-defined Pick Run or Batch Pick Run processes
that let different users reconfigure the robot to their own preferences.

Note: When a Pick Run finishes, the data is accessible in Review Results, but the data is
locked and cannot be modified. See Review Results Process on page 75.
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Start Pick Run

To start Pick Run:

1. Before you continue, make setting changes. On the Pick Run > Start screen:
Change Imaging Settings on page 45
Change Picking Settings on page 47
Change Sanitize Pin Options on page 49

2. Click Start to start the run process .
3. When the Load Container dialog displays, load the source plates into the source stacker.

4. If needed, raise or lower the source stacker.
5. Click Next.

Change Imaging Settings

To edit Imaging Settings, click the Imaging Settings title, or alternatively, the Details tab or
Guide tab.

To change the following:

Run Annotation - Enter a name to identify the run.
Source Microplates - Select the type of source well plates.
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Barcode Options - Select one of the following options:
Read Barcode - Activates the source plate barcode reader. Must be activated for a
Batch Pick Run.

Tip: Using barcodes is recommended. Barcodes must be placed on the front
short side of the microplate (A1 end). Also see Using Barcodes on page 29.

Auto Assign Barcode In Case Of Failure - Automatically generates a unique plate
identifier if the barcode fails to read.
Clear this checkbox to have the system request an identifier to be entered manually.

Note: Compatible barcodes for the system are 39, 93, and 128. Also see Using
Barcodes on page 29.

Batch Plates - Selects the Batch Pick Run option where all plates in the cassette are imaged
and statistics are generated as an aggregate for all plates. The colony selection for the
whole series of plates can be reviewed and adjusted before picking.
Source Plate Options - Select one of the following options:

Prompt For More Plates When Cassette Is Empty - Prompts you to add more plates to
the cassette after all the plates in the cassette are imaged.
Finish When Cassette Is Empty - Ends the imaging process after all the plates in the
cassette are imaged.

Acquisition Options - Select from the list of acquisition options that have already been
created. You can modify this in Preview.
Prime Configuration - Use these settings for detection of all colonies. Generally, this is the
white light acquisition option, although a fluorescent option designed for colony detection
could be used, for example, viability assay.
Review Colony Selection - Select one of the following options:

After First Microplate Only - Displays the Results screen after only the first microplate is
imaged to allow you to adjust the Groups before you commit to picking. These settings
apply to any other plates in the cassette.
After Every Microplate - Displays the Results screen after each microplate is imaged to
allow you to adjust the Groups before you commit to picking.
Batch – Review All - Must be selected when you use the Batch Pick Run. All source
plates are imaged to allow the groups to be adjusted for the whole series of plates
before you commit to picking.
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Change Picking Settings

To edit Picking Settings, click the Picking Settings title, or alternatively, the Details tab or Guide
tab.

You can change the following:

Destination Microplates - Select the type of destination well plates.
Destination Wells - Specify the deposit wells to use. Right-click to select wells and left-click
to deselect wells. All destination plates are filled using this template.
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Barcode Options - Select one of the following options:
Read Barcode - Activates the source plate barcode reader. Must be activated for a
Batch Pick Run.
Auto Assign Barcode In Case Of Failure - Automatically generates a unique plate
identifier if the barcode fails to read.
Clear this checkbox to have the system requests an identifier to be entered manually.

Note: Compatible barcodes for the system are 39, 93, and 128.

Deposit Options - Select to have the destination plate matched to the source plate such
that the completion of picking from each source plate prompts the return of the current
destination plate. When not selected (default), all destination plate wells are sequentially
filled.
Destination Plate Options - Select one of the following options:

Prompt For More Plates When Cassette Is Empty - Prompts you to add more plates to
the cassette after all the plates in the cassette are imaged.
Finish when cassette is empty - Ends the imaging process after all the plates in the
cassette are imaged.

Pick Number Options - Colonies can be picked by source plate or by source well. By
default picks as if all wells of the current plate contain the same sample and are organized
by source plate. Select one of the following options:

Collate By Well - When selected the system picks all specified colonies from well A1
first and then proceeds to the next well. Select this when, for example, wells of a multi-
well source plate contain different samples.
Limit Colonies - Limits the number of colonies picked from each plate or well.

Pin Options - Select one of the following options:
Adherent or Suspension - Select the Adherent option to collect colony monolayers and
select the Suspension option to collect colonies from semi-solid medium. By default,
there is a 500ms delay for Suspension picking to permit the colonies to be fully
collected from the semi-solid medium.
Pick Height Adjustment - The pick height is automatically adjusted for optimal
Adherent or Suspension picking (by default these are 0.1 mm below and 0.4 mm above
well bottom, respectively).
Aspirate Volume - General recommendation is no less than 10 µL.
Dispense Volume - General recommendation is no less than 12 µL.

Audit Options - Saves the target and aspirate images before and after picking a colony. If
you select this option, all images are saved. If you do not select this option, you can toggle
the images on and off while picking but the images are not saved.

Note: This option slows picking dramatically.

Dispersal Options - Selecting dispersal separates the cells of a picked colony by aspirating
and dispensing in the destination plate. If dispersal is required, you can set the following
parameters:

Dispersal Cycles - 3 to 6 for CHO cells and 6 to 10 for hybridomas. Small colonies in
chemically defined media can be left undispersed.
Dispersal Volume - Maximum volume that can be dispersed is 20 µL.

Click Apply To save the settings.
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Change Sanitize Pin Options

To edit Sanitize Pin Options, click the Sanitize Pin Options title, or alternatively, the Details tab
or Guide tab.

Tip: The default settings are appropriate for most situations.

To edit Sanitize Pin Options:

1. Specify the number of purge cycles.
2. Specify the number of cycles the picking pins are scrubbed in the ethanol bath.
3. Specify the number of seconds the halogen dryer is on.

If you create new settings, click Save Process.

Preview

The Preview screen starts the image acquisition and colony detection set up.

The first tab that displays in Preview mode is the Images tab. This initially displays as a gray until
you select an image in the well map to acquire the images.



ClonePix 2 Mammalian Colony Picker User Guide

50 5054791 G

The screen is divided into two panels.

The panel on the left displays the acquired images, with composite, white light and
fluorescent channel thumbnails. To display these thumbnails in the central image frame,
left-click. You can only capture and view one image area of the well at a time, represented
by a light blue rectangle in the Well Map.
The panel on the right, displays the Well Map and several tabs at the bottom that enable
you to adjust imaging settings. Tabs include:

Acquisition - See Image Acquisition Settings on page 50
Detection - See Image Detection Settings on page 51.
Non-cellular - See Non-Cellular Tab on page 65.
Groups - See Groups Tab on page 66.
Statistics - See Statistics Tab on page 69.

Tip: The most important settings to set up correctly are the image Acquisitions and
the Detection of the colonies. Altering these settings later in the process can take a
long time.

Image Acquisition Settings

Use the Preview > Image > Acquisition tab to define settings for image capture. Make sure that
the images are bright but not over exposed to the white or fluorescent light.

Image overexposure displays as red pixels on the image. Where these are seen, reduce the
exposure time.

To select Configurations for image acquisition, double-click each configuration name.

To preview the chosen images in the current image area, click Grab Image.
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Settings include the following:

Well Map - A map of the plate and the selected well displays above each of the settings
tabs. Click any of the wells imaged (displayed in light blue) to display the images for that
well.
Configurations - Defined acquisition options are shown in the My Configurations box after
they are created. To share personal configurations with other users, click on the
appropriate option in My Configurations to highlight the text in blue and then click < to
transfer to the Shared Configurations list.
Prime Configuration - Use for colony detection. Generally, this is the white light acquisition
option or a fluorescent option designed for colony detection, for example, viability assay
such as Live Detect.
Settings - Use to set up and modify acquisition options.

To modify a configuration, click to highlight the text in blue and then click Edit.
Select appropriate settings and then click Save.
To create a new configuration click New, then click the new configuration to highlight
the text in blue, and then click Edit.
Select settings and then click Save.
For white light imaging, use the Trans (transillumination) option. For fluorescent
imaging, use the maximum LED intensity.

Prime Configuration Focus - This is the focus value that the camera uses when acquiring
the images for each configuration.

Image Detection Settings

Use the Preview > Image > Detection tab to define optical settings for detecting colonies within
the prime configuration (white light). It is important at this stage to make sure the all the desired
colonies are detected. Detected colonies are displayed with a colored circle around the
perimeter of the colonies (the color of the circle corresponds to the groups it is automatically
assigned to by default).
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Settings include the following:

Well Map - A map of the plate and the well you select displays above each of the settings
tabs. Click any of the wells imaged (displayed in light blue) to display the images for that
well.
Colony Detection - Select one of the following Algorithms:

Global Threshold - Detection based on single background threshold intensity of the
whole image.
Local Threshold - Detection based on background intensity around the vicinity of the
colony.
Flatten Detection - Locates features by first removing background variations.
Edge Detect - Locates colonies by detecting the transition at the edge of each colony.
This is better suited to detect adherent colonies.

Average Colony Diameter - Use the scale bar on the image to set the most appropriate
average colony diameter. The software searches for colonies within a ten fold range of
colony diameters therefore excluding any large or small features that are not colonies.
Minimum and maximum diameters are shown for the diameter you specify. It is possible to
extend this range by changing the upper and lower limits displayed as drop-down lists. The
default values are the average colony diameter divided by 4 for the lower limit and the
average colony diameter multiplied by 2.5 for the upper limit.
Exterior Statistics Diameter Multiplier - Move the cursor over any colony on the image to
display a red circle around the colony. This defines the area that is used to calculate
Exterior statistics. Use the Diameter Multiplier slider to set the required diameter to the red
circle as multiples of the Average Colony Diameter.
Use Each Colony Size When Calculating Exterior Statistics - Select to use the actual size of
each colony, rather than the Average Colony Diameter so that the larger colonies have a
larger exterior red circle.
To view the effect of any change, click Reprocess.
Display - Use the following options to display various aspects of the images:

Display Detect Colonies - Clear this checkbox to hide colony detection from view to aid
visualization of the underlying raw image.

Note: Be sure to re-select the display, otherwise subsequent processing is
hidden.

Shade Colonies - Select this option to fill the colony outline with the corresponding
color for better visualization.
Identify Colonies - Superimposes a feature ID for each colony.
Display Proximity Indicators - Select to display the nearest adjacent colony for every
detected colony in the image.

Note: This is not the same as the Group Proximity (colony exclusion).

Shade Exclusion Zone - Selected to display the exclusion areas on the image as
hatched red lines. Clear to remove the exclusion areas around the image.



Chapter 4: Picking Processes

5054791 G 53

Select Wells

Use the Select Wells screen to choose which wells to image.

To deselect the wells (showing them as white), right-click on a well .

To select the well (showing them as pink), left-click on a well .

Alternatively, click Select All or Deselect All to add or removed wells to be imaged.
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Summary

Use the Summary screen to confirm that all settings are correct before you proceed to imaging.

Both imaging and picking summaries appear. A well map to the right of the summary identifies
the wells that are imaged.
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Imaging

The Imaging screen displays the images that are being captured as imaging progresses. The
selected wells image in sequence with the acquisition options defined. The images are then
processed together for colony detection according to the defined settings.

A well map displays the wells being imaged (displayed in light blue) and the current image
being taken (displayed in dark blue). A small summary appears below the well map showing the
acquisition details of the image being captured.

To cancel during imaging, click Pause, and then click Terminate.
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Results

The Results screen displays when imaging ends to show you the data in several tabs.

This screen has a similar format to the Preview screen except:

You can use the Well Map to navigate all image areas.
The Acquisition tab displays only the configurations used during imaging. The only settings
you can alter are selection of Prime Configuration.

Use the tabs on the Results screen to discard debris or unwanted colonies and then create
selection groups for picking in the next stage.

To aid with viewing data between tabs, you can select a population by clicking and dragging on
the Scatter / Ranking graphs, or by clicking while holding the CTRL key on the Image tab or
Statistics tab. Colonies you select are visualized as follows:

In the Scatter graph or Ranking plot on the Graphs tab, the data points are colored dark
blue.
Within images, the colonies are highlighted with a blue/white circle.
On the Data Table tab, the data points are highlighted with a blue line above and below the
row.

Note: If you select Review Colony Selection > After First Microplate Only, the Results
screen is bypassed for subsequent plates. See Change Imaging Settings on page 45.
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Overview Tab

The Overview tab displays a summary of the imaging and picking settings.

A summary of the plates imaged displays on the right, including the following:

Source Plates - The source plates imaged are listed here. When clicked, highlighted in blue,
the well map appears below in the Well by Well Group Distribution section.
Destination Plates - The destination plates used in the picking process appear here. At this
stage in the process, no plates are visible because no colonies have been picked.
Well by Well Group Distribution - A selected plate appears here. Each imaged well appears
as a pie chart with each slice of the pie representing a group. The pie size is also
proportional to the number of colonies detected in the well.
Plate Group Distribution - The group distribution of all the wells in all the plates imaged
appears in a pie chart. The percentage of each group appear below the pie chart. When
you move the cursor over this key, the percentages display as the actual number of
colonies in each group. Any discard groups created on the Non-Cellular tab (see Non-
Cellular Tab on page 65) appear together as the Discarded proportion of the pie chart in
dark gray.
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Images Tab

The Images tab displays every image frame from all the plates imaged.

To view a specific image:

1. In the Well Maps, hover the cursor over the frame and click it.
2. Select the Configurations tab, to open the Configurations menu.
3. In the Configurations menu list of the different filters used to image the plate, select the

checkbox for each filter name to view the image.

Hover over the whole plate image to cause either wells (in the case of plates containing multiple
wells) or frames to be highlighted with a surrounding yellow box. When you select a well, a
larger image of the well displays on top of the whole plate image, the Well Map updates to
reflect this selection.

Hover over the whole well image to cause frames to be highlighted with a surrounding yellow
box. When you select a frame, a larger image of the frame displays on top of the whole plate
image and the Well Map updates to reflect this selection. This is Single Image mode.



Chapter 4: Picking Processes

5054791 G 59

While in Single Image mode, frames next to the selected image also appear but display darker.
Click these frames to slide the adjacent frame into view and load the newly selected image. The
Well Map is also functional in Single Image mode and enables quick cross plate navigation.

Below the Well Map are the Acquisition, Detection, Non-cellular, Group, and Statistics tabs.
Select the Acquisition tab or Detection tab to display settings that you selected during the
Preview. See Preview on page 49. You can change these settings but when you use Reprocess,
all the captured images are reprocessed, which can take some time, especially if you use batch
mode and ten plates were imaged. See Non-Cellular Tab on page 65, Groups Tab on page 66,
and Statistics Tab on page 69.

Controls include the following:

Composite - Fluorescent (non-prime) images can be superimposed onto prime images in
the Composite image view. It is possible to change the brightness and so on, of the image
by selecting the checkbox and then using Palette.
Trans WL - The destination plates used in the picking process appear here. At this stage in
the process, no plates are visible because no colonies have been picked.
FITC 1.5 s - Fluorescent checkboxes display below the white light checkbox. If there are
several fluorescent channels used (for example, FITC, RHO, CY5) they are all displayed
individually below the white light checkbox. It is possible to change the brightness and so
on, of the image by selecting the checkbox and then using the Palette.
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Palette - Palette button allows the images on-screen to be enhanced or modified. There is a
palette available for each filter (Composite, White Light, and Fluorescent channels). To
change any of the settings, select the checkbox and click palette. There are various
palettes to choose from for improving the brightness and contrast of the image. The
Highlight Saturation and No Data option (selected as default) displays the red (saturated)
and blue (No Data) pixels on the image. This can be removed by clearing this checkbox.

You can also apply colors to the images on the Channels tab by selecting the channel of
interest and giving it a color using the Change Color option. You can display the fluorescent
channels in the composite image by selecting Display in composite image box. You can
alter the brightness and contrast of the composite image using the sliders in this section of
the palette.
Export - Export Image permits the current image to be exported. The exported image can
be generated with or without detection (user defined) and is shown in the color specified in
the acquisition option. The image can be exported as a .bmp, .jpg, or a .png file.
Select, Ruler, and Area

Select - The default tool, when the cursor is over a colony in Single Image mode, the
properties of that colony appear on the Statistics tab. This tool also allows panning and
zooming around the image.

Ruler - Measures diameter of a colony. Click Ruler, and then drag the cursor across a
colony. Click Select after measurement.
Area - Measures the area of a colony. Click Area, and then click the center of the colony
and drag out to the perimeter. Click Select after measurement.

Full Screen - Enlarges the image to fill the full screen. Press ESC to return to regular view.
Zoom Control - Digitally zoom images. The magnification displays to the right of the Image
Zoom bar, which turns red when the actual image size is exceeded. Beyond this point, the
image becomes pixelated. The scale bar in the bottom left corner of the image pane adjusts
with the Zoom Control.
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Gallery Tab

Use the Gallery tab to define the visualization order of the colonies to be picked. It is possible to
order them according to a fluorescent or morphological statistic, group, and the acquisition
option used (White light, FITC).

The colonies can display using the following settings:

Sort By - Sorts the colonies according to the statistic chosen from the drop-down list. This
can be a fluorescent statistic or a morphological statistic.
Descending - Select the checkbox to arrange the colonies in descending order from left to
right. Clear the checkbox to arrange the colonies in ascending order from left to right.
Group - Enables all the features or any of the groups to be displayed.
Image - Enables the white light or fluorescent image of the colonies to be displayed.
Zoom - Magnifies into and out of the image by moving the slider from left to right.
Viewing Colonies - Shows the number of colonies being viewed.
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Data Table Tab

The Data Table tab displays the statistics for colonies detected in the image. Each line
represents a detected colony colored according to its Group. Fluorescent image parameters
denoted by the prefix [acquisition option] display to the left and Prime (white light) image
parameters display to the right. By default, parameters are listed in alphabetical order. Click a
column header to sort data by the other parameters. Click a second time to invert the order.

The data table is interactive. Double-click on a row of colony data to link to the image of the
colony (identified with a blue circle). Alternatively, right-click a row to display a list of link
options.

The right-click menu also allows you to manually link colonies to a Group. Any modifications to
automatic grouping are logged in the statistics column Manual Group.

Select a row to display the statistics for that colony on the Statistics tab to the right of the data
table.

Statistics are ordered for easy viewing:

Colony Images - When you select a colony in the data table, the corresponding image
displays to the left of the table. you can change the size of the colonies in the thumbnails by
using the Zoom slider at the bottom.
Select Statistics - There are various statistics that appear as default, however you can
display only the preferred statistics. To do this, open the select statistics window and select
the desired statistics. After you click Close, only the chosen statistics display and the drop-
down lists on the Graphs tab.

Note: Deselecting statistics hides only the data from view and can be reselected at
any time.

Export Statistics - Select this to open a window to export data. Only statistics for picked
colonies or all detected colonies can be exported. Data can be exported as:

CSV format for opening as a single sheet in Excel and other statistics software.
Excel-XML format for opening in multiple sheets in Excel and other statistics software.
XML format for compatibility with LIMS and other bespoke software. This is not
functional in Preview.

Generate Report - Selected to run a wizard to generate an XML-based summary of a run.
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You can export the following information into the Report for each plate processed:
Imaging Settings - All settings applied during set up.
Picking Settings - All settings applied during set up. Only available for a completed Pick
Run.
Statistics - All the statistics you select in the data table are entered into the report. It is
recommended that these are excluded from the report as the data table is extensive
and this makes the report large. It is recommended that statistics are exported through
Export Statistics.
Scatter Plot - The last Scatter plot to be created on the Graphs tab is entered into the
report.
Rank Plot - The last Rank plot and Histogram created on the Graphs tab is entered into
the report.
Pick Summary - All the details from the Picking Review tab are entered into the report.
As well as giving the report a name, you can enter the following information into the
wizard; Title, Cell Type, Project Details, Plating Efficiency, Incubation Time, Summary.

Graphs Tab

Use the Graphs tab to create groups. Each point that displays within the graphs is a detected
colony. The color of each point indicates the group that the colony has been assigned to. Hover
over each point on the graphs to display the corresponding colony in the image thumbnails to
the left of the graphs.

Graphing options include the following:

Scatter - When you select a colony in the data table, the corresponding image displays to
the left of the table. Use the Zoom slider at the bottom to change the size of the colonies in
the thumbnails.
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Rank - There are various options when looking at results and creating groups in the ranking
plot. When you select Rank, the Rank Plot displays at the top of the screen and a Histogram
displays beneath the rank plot.
Rank Plot - Display either the rank plot or a well image. When you select Show Graph, the
ranking plot displays above the histogram. The Rank Plot and Histogram statistics are
linked. When you select a statistic in one graph, it is also displays on the other. You can
select to Log Scale the Y Axis in the Rank Plot and also zoom into an area on the graph.
When you select Show Image, the image of the well you select displays above the
histogram. As you create or edit groups, the color change of the colonies update on the
image.

Rank Plot is interactive. Double-click a data point to link to the image of the colony
(identified with a blue circle). Alternatively, right-click on a data point to displays a list of link
options. Right-click on the background to copy the current graphic image.
Histogram - Create groups using this histogram by selecting a statistic from the drop-down
list and drawing a line gate where required. You can also change group default values here.
Display allows you to visualize the grouping histogram by Stack By Group or by Totals Only.
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Non-Cellular Tab

Use the Non-Cellular panel to remove any kind of debris from the data set, for example, hairs,
small scratches, and small bubbles, that are not colonies before you decide which colonies to
pick. By removing debris from the data set before you create groups, the debris is not
considered as being part of the data. This means that real colonies are not put into the Proximity
exclusion group if they are too close to debris. There are two discard groups by default; NC
Irregular 1 and NC Irregular 2. These groups exclude debris based on compactness and axis
ratio respectively. You can delete these groups if not required. Non-Cellular discard groups can
be created by selecting a statistic from the drop-down list and drawing the discard line (icon
denoted by a red cross) on the histogram.

You can create several of these Non-Cellular discard groups and these groups are listed on the
Non-Cellular tab. By default all discard groups listed on the Non-Cellular tab are colored red but
you can change this if needed. Discard groups can also be hidden by selecting the group and
selecting the Hidden checkbox.
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Groups Tab

Use the Groups panel to visualize detected colonies and their corresponding groups and to
create new groups for picking. You can optimize and setup groups at the Preview stage, but it is
best to create groups after imaging. The grouping system is designed to generate exclusion
groups for example, Too Small, Irregular, Proximity, and inclusion groups to pick specific
populations, for example, High FITC, High Rhodamine. You can pick multiple groups in the
same picking run and you choose which groups to pick later on the Picking Review Tab on page
69.

Image thumbnails display to the left of the graphs where you can hover over the points on the
graph to visualize the colonies.

There is the option to change between Rank and Scatter graph for plotting statistics and
creating new groups.

The grouping system works by priority with the group at the top having highest priority. For
example, a colony that would fall into two groups is placed in the highest priority group.

Click Increase Priority and Decrease Priority to change the group priority. Colonies that do not
fall into an exclusion group are retained in the bottom category. By default, this is named
Ungated as these are ‘good’ colonies that have not been rejected by morphological
characteristics or close neighbor proximity.

The bracketed number to the right of the group name indicates the number of colonies in the
group.

Spot Count

Total - Displays the total number of colonies assigned to the groups you select.
Manual - Displays the number of colonies you manually assign to the group.
Pickable - When you select All Undiscarded Features, this displays the total number of
pickable colonies.
Revert to Defaults - Click to change all the group values back to the original default values.



Chapter 4: Picking Processes

5054791 G 67

There are six default exclusion groups:

Edge Excluded - Edge excluded colonies are outside the pickable region of the well and
cannot be selected. This group has highest priority and cannot be moved to a lower priority.
Too Big - Colonies greater in size than 0.7mm2 fall into this group.
Too Small - Colonies smaller in size than 0.1mm2 fall into this group.
Irregular 1 - Colonies that have a Compactness value less than 0.6 fall into this group.
Irregular 2 - Colonies that have an Axis Ratio value less than 0.6 fall into this group.
Proximity - Colonies that have a Proximity value less than 0.1 mm fall into this group.

Double-click the group name to display the group and its gate on the histogram where you can
edit the group.

Move the slider on the histogram to a new value or enter the new value in the Upper Bound
Value field in the lower right corner of the histogram (press ENTER to apply changes). The group
gate displays the colonies that now fall into the altered group.

At the bottom of the Groups tab, you can enter a new name for the group and press ENTER.
Select the Hidden checkbox to hide the group from view. This hides the group from view on all
images and in the Data Table tab and Graphs tab. Click Color to change the group color.

Select a group and click Remove to delete the group. You cannot delete the Edge Excluded
group or the Ungated group.

The bottom category (Ungated by default) is not a defined group and so does not have a gate
on the histogram that can be changed.
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Creating New Groups

Example: Creating a group for picking high FITC-expressing colonies.

A white light Prime image and a FITC fluorescent image must be acquired to do this example.

To create a new group:

1. On the Graphs tab, click Rank to display the rank plot and histogram .
2. Select a fluorescent statistic from the drop-down list, for example, [FITC] Exterior Mean

Intensity or [FITC] Sum Total Intensity. This displays on both graphs.

3. Click New Line Gate, click the histogram where the group will start and drag the line
off the end of the histogram to create the group.

4. Name the group, for example, High FITC, give it a color and click OK.
The group displays below the Edge Excluded group.

5. Select the new group and decrease its priority so that it displays above the Ungated
category.

Decrease Priority - Only colonies with good morphological and proximity characteristics
can be put into the new group.

All colonies in this group display in the Group color on the Images, Statistics, and Graphics tabs.
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Statistics Tab

On the Statistics tab, you can view statistics for any colony on the Images, Data Table, Graphs,
and Picking Review tabs.

Select the Statistics tab to display the statistics for a colony of interest. You can categorize the
statistics in this list (Fluorescent Intensity, General, Intensity, Morphology, Position) or order the
statistics alphabetically.

Picking Review Tab

The Picking Review tab displays a summary of the colonies to be picked. Any number of groups
can be selected to be picked here, and to be ordered using various criteria.

A summary of the picking review tab appears to the right of the main screen, including the
following:

Colony Images - When you select a well in Deposit Wells, the corresponding colony image
displays on the left. Use the Zoom slider to zoom in and out of the colony images.
Picking Groups - All the groups available to be picked are listed here, including exclusion
groups such as Too Small and new groups that you create with specific characteristics.
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Sort Options - Provides several ways to sort colonies.
Order by - Allows colonies within a checked group to be picked in order of any of the
parameters in the drop-down list, for example Fluorescent Exterior Mean Intensity. If
you select several groups, you should order by Group.

Pick Summary - Displays the number of colonies to be picked and the number of
destination plates into which colonies are picked.
Deposit Plates - Lists the number and type of destination plates (as previously defined in
Modify Settings, Picking Settings) that are required for picking.
Deposit Wells - Displays the wells that the colonies are going to be picked into. The wells
are colored according to the corresponding colony that is picked into them. Any wells that
have been excluded from picking display with red crosses over them. Underneath the well
map, the following information displays when you hover the curser over the colony
assigned wells:

Source Barcode - Displays the barcode of the source plate where the picked colony
comes from.
Source Well - Provides the source well number of the picked colony.
Order By Value - Provides the order value (assigned from the sort options drop-down
list) of the colony to be picked.

Picking Summary

The Picking Summary screen displays the pick information before the picking starts.

Click Next to start picking.

To go back to the Results screen where you can make changes, click Back.

CAUTION! Selecting Back reprocesses all the images captured, which can take a while if
several plates have been imaged.

When you start the picking, a message prompts you to load the destination plates into the
destination stacker cassette. Raise or lower the destination stacker, if needed.
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Pick Colonies

The Pick Colonies screen displays the Picking Progress as the colonies are being picked. The
automated picking step initiates with a pin wash.

Screen options include:

Microplates - This section displays a schematic of the source plate and the destination
plate. As colonies are being picked from a well of a source plate, the well is colored pink. As
the colonies are being picked into the destination plate, the wells are colored pink. The
barcodes of the plates being used appear and any wells not being used display a red cross
over the well.
Colony Images - As colonies are being picked, several pieces of information display; source
plate barcode and well number, destination plate barcode and well number, a thumbnail
image of the colony to be picked, a thumbnail image of the pin in place before the colony is
picked and a thumbnail image of the pin in place after the colony has been picked. It is
optional to have the before and after images display. Select or clear the checkbox before
and after images.
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Options - Select from the options to stop the colony picking, including:
Change Wash Bottle - Enables sterile water to be replaced during the picking.
To activate:

Click Pause
Select Change Wash Bottle, and then click Continue.
Immediately before the next wash cycle, a prompt appears to swap over the bottle
(if needed), and starts the long purge. The next cycle of pin washing reverts to the
original purge settings.

Pause - Temporarily stops at any point during the picking.
Park Safe - When in Pause mode, you can move the picking head to the Park Safe
position. Click Continue to restart the picking.
Terminate - When in Pause mode, the picking ends immediately. Use with caution.

Imaging - When selected, the camera repositions and displays on-screen images of the pin
tip before and after picking. Options include:

Image Before Pick - Select to display each colony immediately before being picked.
Image After Pick - Select to display if each colony has been successfully collected by
the pin.
You can switch these options on and off at any time during the run.

Note: These images are not saved. If saving the images is required, see Change
Picking Settings on page 47 and select the Save Target and Aspirate Images.

Note: Activating these images significantly slows the picking speed, and small
colonies might not be visible.

Sanitise Pins

In between each pick and at the end of each run, the pins are cleaned as specified in the
Sanitise Pins Options set up. See Change Sanitize Pin Options on page 49.

Finish

When the picking ends, the Finish screen appears.

Click Finish to return to the Pick Run process Start screen. See Start Pick Run on page 45

To return to the Main Navigation screen click Close Process. If the process has not been saved,
a prompt displays for the settings to be saved.

To view the results of the picking run, go to Review Results. See Review Results Process on
page 75.
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Imaging Run Process

Use the Imaging Run process for plate imaging without committing to a picking run. The default
process includes all the parameters required for a standard imaging run, including image
acquisition, colony detection, and group settings.

Note: Images acquired using this process cannot be used for picking later.

After imaging, source plates return to the stacker cassette, and then the process ends. Imaged
microplate results are accessible in Review Results with data for all detected colonies. Imaging
run data can be reprocessed in Review Results. See Review Results Process on page 75.

Start Imaging Run

To start Imaging Run:

1. Before you continue, make setting changes. On the Imaging Run > Start screen, you can
change the following settings:

Change Imaging Settings on page 45

2. Click Start to start the run process.
3. When the Load Container dialog appears, load the source plates into the source stacker.

4. Raise or lower the source stacker, If needed.
5. Click Next.
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Preview

The Preview screen starts the image acquisition and colony detection set up. This is the same
process as Pick Run. See Preview on page 49.

Select Wells

Use the Select Wells screen to choose which wells to image. This is the same process as Pick
Run. See Select Wells on page 53.

Summary

Use the Summary screen to confirm that all settings are correct before you proceed to imaging.
This is the same process as Pick Run. See Picking Summary on page 70.

Imaging

The Imaging screen displays the images that are being captured as imaging progresses. The
selected wells image in sequence for each of the acquisition options you select. The images are
then processed together for colony detection according to the defined settings. This is the
same process as Pick Run. See Imaging on page 55.

Results

If you select the Display Results option, see Change Imaging Settings on page 45. The results
appear after imaging. The Results screen has a similar format to the Preview screen. Use the
Well Map to navigate the images and to view collated statistics for the entire plate. You can
adjust Groups options. See Groups Tab on page 66.

If you do not select the Display Results option, you can access the images and results from the
Main Navigation screen > Review Results.

Finish

The finish screen displays when the picking ends.

Click Finish to return to the Imaging Run process Start screen. See Start Imaging Run on page
73.

Click Close Process to return to the Main Navigation screen. If the process has not been saved,
a prompt displays for the settings to be saved.

To view the results of the picking run, go to Review Results. See Review Results Process on
page 75.
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Review Results Process

Use the Review Results process screen to review a completed Imaging Run and Picking Run.

By default, data is stored on the C: drive in a folder named Image Archive.

To open the Image Archive, click Next or to access data remotely, click Browse.

The Sessions tab displays a list of completed runs:

The runs appear in two tabs:

Sessions tab - Results appear as one row even if the run consisted of several plates.
Plates tab - Results appear as one row per plate processed so if there were three plates in
the run, three individual rows appear.

Click the column headers to sort the results list or a double-click to invert the selection.

To view the data, do one of the following:

On the Sessions tab, either double-click on a row or click once on a row and the click View
to open the data set.
On the Plates tab, do the same as in the Sessions tab, or to view multiple plates, use Shift-
Click or Control-Click to highlight the rows, and then click View. You can also combine the
data from multiple plates and view and process the plates as a batch.
Search the data sets using Find. The following fields are available to search: Date, Run
Type, Annotation, Operator, Microplate, Barcode, and Machine Name.

When you select a data set, the following information displays:

Source Barcode List - Lists the barcodes on the source plates used.
Optical Configurations - Lists the optical configurations used in the run and the colors
associated with them.
Image Thumbnail - Displays the prime configuration well image.
Destination Barcode List - Lists the barcodes on the destination plates used.
Colony Detection - Displays a summary of the parameters used to detect the colonies.

After you open data for viewing, depending on whether imaging or picking data is being
opened, the tabs available are the same as seen throughout the Pick Run and Imaging Run
stages. In a picking run data set, the Picking Review tab is visible. See Picking Review Tab on
page 69.
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Note: For data integrity, Pick Run data is fully accessible in Review Results but the data
are locked and cannot be changed. Imaging Run data can be changed but cannot be
saved.

Archive - Stores data to Image Archive or transfers data to CD or DVD. Shift-click or Control-
click to highlight the required rows and then click Archive.
Delete - In Image Archive, select a data set and click Delete to remove the data from the
hard drive.

Export Results Data

For Pick Runs, an Output Results tab displays destination plate, well and barcode information.
Pick Run data are non-modifiable to provide an accurate record of the run.

For Imaging Run, data are modifiable on the Detection tab and Group tab, but your changes are
not saved when you close the file.

You can export Graphs and Images or copy them to the Windows clipboard or saved as a file.
You can paste them into presentations, or other applications for sharing.

You can export Statistics with a choice of data formats including comma-separated values
(CSV), XML, and Excel-XML. On the Statistics tab, click Export Statistics.

Generate a Results Report to provide a summary of a run including its settings. Create it on the
Review Results process screen or the Remote Data Viewer software in XML format so that it can
be opened in a web browser and printed or stored electronically. To create a Results Report
from the Statistics tab, click Generate Report.

Remote Data Viewer

Remote Data Viewer software is an optional software to access ClonePix 2 software results
remotely on another computer (order code: SL4950-A01). You can install it on one computer.
The format is identical to the Review Results features in ClonePix 2 software, and allows you to
access results from a ClonePix 2 system through a network or copies of runs transferred
elsewhere.

Data Tracking Logs

A Data Tracking Log file is created for each run. This is an XML file with the same schema used
by other instruments. It includes some statistical information for each colony along with a
‘replicate’ element for each transfer from a source well to a destination well.

The Data Tracking log can be of interest for those wishing to automatically process the transfer
of samples between plates. However the Automatic Logs option can be more useful.

Data Tracking Logs are generated in the ‘Data Tracking’ sub folder of the configuration folder.
The configuration folder is stored under the local applications data folder.

On Windows 7 and Windows 10:

C:\ProgramData\Molecular Devices\Fusion\ClonePix 2\DataTracking

One file is generated for each imaging or picking run. The file name is derived from the data and
time of the run, and the file extension is XML.



Chapter 4: Picking Processes

5054791 G 77

Automatic Logs

Note: To enable the Auto Logs, ask Molecular Devices Technical Support.

Auto Logs can generate by the system for each run with some level of control of their content.

Note: Auto Logs do not generate by default. When enabled, one log is generated for
each run.

The log is broadly the same format as that provided by the Export Statistics in Review Results or
the Remote Data Viewer. See Export Results Data on page 76 and Remote Data Viewer on
page 76.

When the Auto Logs function is active, the folder generates for each run with a name derived
from the data and time of the run. A file saves in the folder with the name Auto.csv or Auto.xm,
depending upon the file-type selection.

Raw Data

The default location for raw data (TIF images and XML files) is: C:\image archive.

CAUTION! Viewing data from this location is not recommended.
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Chapter 5: Utility Processes

Utility Processes provide several processes to control and maintain the hardware.

Picking Head Management

Use Picking Head Management functionality each time the picking head is removed or
replaced.

Removing the Head

To remove the picking head:

1. Click the Remove Head icon to bring the head to the removal position.
2. On the picking head, remove all of the tubing from the left side of the head.

Tip: Place a microplate lid under the picking head to collect any drops of water.

3. On the right side, loosen the thumbscrew that secures the head to the actuator assembly.

CAUTION! Do not lose the washer.

4. Slide the head out of the actuator while being careful not to damage the pins.
5. To return the actuator to a safe position, close the door and click Next.

For picking head cleaning procedures, see Cleaning the Picking Head on page 88.

Replacing the Head

CAUTION! When handling the picking head take care that the pins are not knocked.
Damage to pins can produce unreliable results and can cause serious damage to the
instrument. If you suspect any pin damage, replace them immediately.

To replace the picking head:

1. Click Replace Head to bring the head to the replacement position.
2. Slide the head on to the actuator while being careful not to damage the pins.
3. On the picking head, attach the picking tubing, and on the right side, tighten the

thumbscrew that secures the head to the actuator assembly.
4. Replace the tubes starting from the back, pushing on the picking tubing.
5. Click Next to continue to Pin Fire Test. See Pin Fire Test on page 35.
6. Click Next to continue to Alignment for plate and primary pin. See Alignment on page 36.
7. Click Next to continue to Pin Offsets. See Adjusting Pin Offsets.

5
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Adjusting Pin Offsets

The Pin Offsets process aligns the remaining seven pins relative to the primary pin. Run this
whenever you remove or replace the pins compensate for µm differences between pins.

CAUTION! If you touch the pins or move the pins in any way, you must adjust the pin
offsets for pin one and pins two through eight.

To adjust pin offsets:

1. Following on from Alignment, see Alignment on page 36, you are prompted about using the
same plate. To continue, click Next, or to cancel, Close.

2. To continue and extend the Primary Pin into well A1, click Next.

Note: The datum point for the primary pin cannot be set here. It should already have
been set in the Alignment procedure. If the primary pin is misaligned, exit the
Replace Head process and start again.

3. Click Next Pin to extend the next pin into well A1.
4. Align the pin using the X and Y axis Jog buttons until the pin hole is centered on the red

cross.
5. When the pin is in the required position, click Set. The new pin coordinates appear in red.
6. To move through and set the remaining pins, click Next Pin.

Note: If you click Previous Pin, the pin might appear not to be aligned because the
actual position is shown rather than the offset on the assumption that you want to
create the offset.

Pin Correctly Aligned to Camera and Pins 2 and 3 Already Aligned Shown in red

7. Click Next for Wash Bath Utility. See Wash Bath Utility on page 40.
8. Click Next for Sanitize Pins in 70% Ethanol. See Alternative: Sanitize Pins in 70% Ethanol on

page 41.
9. Click Next for Ultra Violet Sanitize. See Ultra Violet Sanitize on page 41.
10. Click Next for Sanitize Pins to purge the system with sterile water. See Sanitize Pins on

page 42.
11. Click Next twice to automatically park the head safely, return the source plate, and close

the illumination cover.
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Utility Process

The Utility Process screen includes much of the same functionality as the Prepare for Pick Run
process, with the exception of Plate Handing settings. See Prepare for Pick Run on page 35.

Plate Handling - Set Source Plate and Destination Plate handling.

To set source plate handling:
For Plate Station, select Source Stacker.
For Microplate, select the plate type to use.
Click Get Plate and confirm that the plate collects from the Source Plate Station.
Click Return Plate and confirm that the plate returns to the Source Plate Station.

To set destination plate handling:
For Plate Station, select Destination Stacker.
For Microplate, select the plate type to use.
Click Get Plate and confirm that the plate collects from the Destination Plate Station.
Click Return Plate and confirm that the plate returns to the Destination Plate Station.

Sanitize Pins - See Sanitize Pins on page 42.
UV Sanitize - See Ultra Violet Sanitize on page 41.
Wash Bath Utility - See Wash Bath Utility on page 40.
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Chapter 6: Maintenance and Troubleshooting

Before operating the instrument or doing maintenance operations, make sure that you are
familiar with the safety information in this guide. See Safety Information on page 6.

WARNING! Service or maintenance procedures other than those specified in this
guide can be done only by Molecular Devices qualified personnel. When service is
required, contact Molecular Devices Technical Support. See Obtaining Support on
page 96.

Doing Preventive Maintenance

You should do daily and weekly maintenance. We strongly recommend that a complete
instrument preventative maintenance service be done annually by Molecular Devices.

Daily Maintenance

Check that the instrument interior is clean and free from any obstruction.
Ensure sterile water feed bottle is connected to the system fluid supply line. Empty the
waste bottle every time that a new sterile water bottle is connected.
If the system has been sanitized, purge the system fluid supply line on first use to remove
air bubbles that develop overnight. If there is doubt about sterility, run the Prepare for Pick
Run routine that includes a purge of the system fluid supply line.
During the purge, check that there are no air bubbles in the supply line coming from the
sterile water bottle, which will indicate a fault in the connection, and that there are no leaks
around the picking head , which will indicate a blocked pin. If there is a leak, or if a tube
detaches from the head, replace blocked pin with a new one or follow the pin cleaning
procedure. See Cleaning the Head and Pins on page 87.
Fill ethanol wash bath with 70% ethanol. For systems fitted with a replenishing ethanol wash
bath, check that there are no kinks in the tubing and then run through with 70% ethanol.
Check that the bath fills with ethanol and that the waste ethanol flows freely into the waste
bottle. On first use, it might be necessary to run through several times.

Weekly Maintenance

Any week that the ClonePix 2 system is not used, it is important to purge the system fluid
supply line with sterile water and sporicide. Failure to keep the pumps regularly primed may
lead to system malfunction.
Sonicate the picking pins.
Check operation of interlock switch and emergency stop.
Check the compressed air filter for signs of moisture. If necessary, push the drain upwards
to force moisture out.
If you use the external air compressor, drain the accumulated moisture from the internal air
tank weekly. If you use the external air compressor, drain the accumulated moisture from
the internal air tank.

Monthly Maintenance

Sanitize the picking head and silicon fluid tubing.
Sanitize the source plate illumination cover.

6
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Annual Maintenance

A complete instrument maintenance should be done every six months by an approved service
engineer. To obtain a maintenance contract or schedule a service visit, contact your
representative or technical support.

As needed

If the instrument is used in dusty conditions, check the HEPA filter or pre-filter and have
Molecular Devices replace it more frequently than recommended.

Changing Pins

The pins need to be removed from the picking head for cleaning and to change to a different
pin type.

CAUTION! If you touch the pins or move the pins in any way, you must adjust the pin
offsets for pin one and pins two through eight. See Adjusting Pin Offsets on page 80.

To change pins:

1. Click Replace Head to bring the head to the replacement position.
2. On the picking head, remove all of the tubing from the left side of the head.
3. On the right side, loosen the thumbscrew that secures the head to the actuator assembly.

CAUTION! Do not lose the washer.

4. Slide the head off of the actuator and continue working over a workbench

.

5. On the picking head, use the Pin Removal Key (X4948) to turn counter-clockwise and
loosen each of the pins.

6. Before installing the new pins, verify that each pin has an O-ring (X1036) on the thread.
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7. When installing each pin into the picking head, use the Pin Removal Key to turn the pin
clockwise until you feel some resistance.

CAUTION! Do not over-tighten.

8. Slide the head onto the actuator while being careful not to damage the pins.
9. On the picking head, attach the picking tubing, and on the right side, tighten the

thumbscrew that secures the head to the actuator assembly.
10. Replace the tubes starting from the back, pushing on the picking tubing.
11. Click Next to continue to Pin Fire Test. See Pin Fire Test on page 35.
12. Click Next to continue to Alignment for plate and primary pin. See Alignment on page 36.
13. Click Next to continue to Pin Offsets. See Adjusting Pin Offsets on page 80.

Cleaning the Instrument

Follow all of the cleaning procedures outlined in this guide for the instrument.

Do the following before you clean equipment that has been exposed to hazardous material:

Contact the applicable Chemical and Biological Safety personnel.
Review the Chemical and Biological Safety information contained in this guide. See
Chemical and Biological Safety on page 10.

Avoid spilling liquids on the system. Fluid spilled into internal components creates a potential
shock hazard. Wipe up all spills immediately. Do not operate the system if internal components
have been exposed to spilled fluid. Unplug the instrument if there is a fluid spill in the
instrument and contact Technical Support.

Perform only the maintenance tasks described in this guide. Contact a Molecular Devices
service engineer to inspect and perform a preventive maintenance service on the instrument
each year. See Obtaining Support on page 96.

WARNING! BIOHAZARD. It is your responsibility to decontaminate components of
the instrument before you return parts to Molecular Devices for repair. Molecular
Devices does not accept items that have not been decontaminated where it is
applicable to do so. If parts are returned, they must be enclosed in a sealed plastic bag
stating that the contents are safe to handle and are not contaminated.

Clean all components that come into close contact with biological materials. For efficient
decontamination of pathogenic micro-organisms, wipe all non-removable parts within the
instrument with a cloth using 70% ethanol.

CAUTION! Molecular Devices recommends that you always use ethanol for cleaning,
because autoclaving is not compatible with anodized parts. Do not use abrasive
cleaners, because it damages the surface of the bed.

The instrument can be left in a laboratory during formaldehyde vapor fumigation at an
appropriate concentration.

CAUTION! Excessive formaldehyde treatment damages sensitive electrical and optical
components.
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Sterility Validation Tests

To test the sterility of your environment:

Chamber Sterility Test

To test chamber sterility:

1. Prepare the instrument using the cleaning procedures provided.
2. Place a Trypticase Soy Agar* plate open on the process bed during a prolonged

mammalian cell picking run.
*A general purpose medium which supports the growth of fastidious and non-fastidious
microorganisms.

3. After 20 minutes, cover the plate, remove the plate, and replace the plate with another
open plate.

4. Repeat steps 1 and 2 six times spanning two hours.
5. Incubate the plates at 37°C for two weeks to encourage any potential contaminant growth.

The chamber is sterile when after this period there is no contamination on any of the agar
plates.

Mammalian Cell Picking Sterility Test

To test mammalian cell picking sterility:

1. Prepare the instrument using the cleaning procedures provided.
2. Plate CHO-S cells in chemically defined medium without antibiotics and render them semi-

solid using CloneMatrix.
3. Incubate the plates at 37°C for 10 days to grow the cells into clonal colonies.
4. Select colonies (n=175) using the instrument into 96-well plates prefilled with 200Rl liquid

medium without antibiotics.
5. Grow the picked cells for 12 days, replenish with fresh liquid medium without antibiotics,

and then expanded to exhaustion for four weeks.
Sterility is confirmed when after four weeks there is no visible contamination in any of the
wells.

Cleaning the System Fluid Supply

The cell collection process relies on the presence of non-expandable system fluid between the
pumps and the picking pins. The ClonePix 2 system uses sterile water for the system fluid
supply. The system fluid is fed in from a detachable wash bottle and the waste fluid is voided
directly to the waste bottle. The system fluid is also used to purge out the picking pins between
each cycle of picking.

Change the Wash and Waste bottles using the quick-release connectors with the check valves
that close when the connection is broken. Molecular Devices recommends liberally spraying
the connectors with Spor-Klenz Ready-To-Use Cold Sterilant before re-connecting.

To ensure a sterile supply of system fluid, sanitize the system fluid lines once a week, and after
any length of non-use. Follow the software procedures in Prepare for Pick Run on page 35.
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Cleaning the Head and Pins

The reusable pins in the head are sanitized when you run a process that includes a Sanitise
profile. They are cleaned before the first pick, between each cycle of picking, and at the end of
the run.

You can leave the picking head installed and spray it with 70% ethanol and it dry in the HEPA
laminar air flow.

For a more thorough cleaning of the head and pins, remove the head from the actuator. See
Removing the Head on page 79.

The head is housed in an actuator system that permits easy exchange and set-up of the head.

Although it is possible to manually move the actuator assembly, Molecular Devices
recommends using the software to safely move the actuator into position to remove or install
the head. See Picking Head Management on page 79.

WARNING! The actuator assembly has moving parts that can cause pinch injuries if it
is moved manually. To prevent pinch injuries, use the software Change Head process
to safely move the actuator.

Before storing the head, or whenever it needs cleaning, wipe the exterior of the head with a
cloth using 70% ethanol.

To store the head, slide it into its metal cover with the pins facing inward and then secure it in
place with the thumbscrew and washer.

Note: Automated cleaning with a Sanitise profile does not replace sonicating the pins.
See Sonicating the Pins on page 90.
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Cleaning the Picking Head

You can thoroughly clean the picking head with either ethanol or a sterilizing agent.

CAUTION! Autoclaving the head is not recommended because it can cause functional
deterioration. Molecular Devices recommends at least one picking head for each project.

Picking Head Without Pins

Cleaning the Picking Head With Ethanol

To clean the picking head with ethanol:

1. Remove picking head from the instrument and remove the pins and the picking tubing. See
Removing the Head on page 79.

2. Submerge the head and O-rings into 100% ethanol.
3. Press the piston actuator to allow the interior to fill.

4. Soak for 10 minutes.
5. In a sterile environment, lift the head out of the ethanol.
6. Press the piston actuator to allow the interior to empty.
7. Leave to air dry.
8. Replace the picking head. See Replacing the Head on page 79.
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Cleaning the Picking Head With Sterilizing Agent

To clean the picking head with sterilizing agent:

1. Remove picking head from the instrument and remove the pins and the picking tubing. See
Removing the Head on page 79.

2. Prepare the sterilizing agent in 1 liter of warm water.
3. Submerge the head into the sterilizing agent.
4. Press the highest piston to allow the interior to fill.
5. Soak for 10 minutes.

CAUTION! Do not leave the head in the sterilizing agent for longer than 10 minutes
because acetic acid generated as a by-product can cause discoloration or functional
deterioration.

6. In a sterile environment, lift the head out of the sterilizing agent.
7. Press the piston actuator to allow the interior to empty.
8. Submerge the head into a beaker of sterile water.
9. Press the highest piston to allow the interior to fill.
10. Remove the head from the sterile water.
11. Press the piston actuator to allow the interior to empty.
12. Repeat steps 8-11 multiple times to remove the sterilizing agent.
13. Hold the head over an empty beaker and spray it liberally with 100% ethanol including the

interior.
14. Press the piston actuator and ensure that the interior is well drained.
15. Leave to air dry
16. Replace the picking head. See Replacing the Head on page 79.

Cleaning the Picking Pins

Note: Molecular Devices recommends at least two sets of Picking Pins for each project.

The reusable Picking Pins are frequently cleaned automatically during a picking run.
Specifically, they are cleaned before the first pick, between each cycle of picking, and at the
end of the run.

There are four components to the automated cleaning process:

Sterile water unidirectional purge to clean the internal bores of the picking pins.
Ethanol Wash Bath brushing of the picking pins for effective mechanical cleaning of the pin
exterior.
Halogen dryer to heat the picking pins and remove residual ethanol.
Sterile air blower blows over the picking pins to cool them and ready them for the next pick.

Note: The length of each of the above steps can be user defined according to the
application, but the halogen dryer should not be run for less than 10 seconds.

CAUTION! The automated cleaning is not designed to replace the sterilization of picking
pins by sonication.

Sterilize the Picking Pins, O-rings, and Pin Removal Key regularly through sonication. See
Sonicating the Pins.
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Sonicating the Pins

You should sonicate the pins weekly. Before sonicating the pins, remove the pins from the head
and sonicate the pins only.

To clean the head, wipe it with a cloth using 70% ethanol. If necessary for further
decontamination, soak the head in 100% ethanol. Before reassembly, make sure that all parts
are thoroughly dry.

If necessary, you can soak the springs and screws in 100% ethanol and then let them thoroughly
dry.

To sonicate the picking pins:

1. Prepare a 2% solution of aQu Clean Microarray Pin Cleaning Solution.
2. Sonicate the pins in the 2% aQu Clean solution for 10 minutes.
3. Rinse the pins with deionized water.
4. Sonicate the pins in deionized water for 10 minutes.
5. Rinse the pins with 100% ethanol, or autoclave.
6. Allow the pins to thoroughly dry in a biosafety hood for a few hours or overnight.

Cleaning the Wash and Waste Bottles

We recommend at least three Wash Bottles and one Waste Bottle for each project. One Wash
Bottle should be kept for cleaning the system fluid supply with 70% ethanol or sterilizing agent.

The Wash Bottles that are connected to the Feed tubes must be sterile before use.

To clean the wash bottles:

1. Fill the Wash Bottle with deionized water.
2. Replace the bottle cap loosely.

CAUTION! Failure to leave the bottle cap on loosely can damage the bottle.

3. Seal the air inlet pipe with an autoclavable 0.2 µm (microns) disposable filter.
4. Autoclave using standard conditions: 121°C at 15 psi (103 kPa) for the required time. The time

required to ensure sterility depends on your autoclave system.

CAUTION! Do not autoclave the bottles filled with alcohol or sterilizing agent.

Cleaning the Wash and Waste Tubing

The Wash and Waste Tubing are silicon tubes that connect the Wash Bottle and Waste Bottle.

Remove the tubes and autoclave as required using standard conditions: 121°C at 15 psi (103 kPa)
for 20 minutes.



Chapter 6: Maintenance and Troubleshooting

5054791 G 91

Cleaning the Picking Tubing

The Picking Tubing consists of eight silicon tubes that connect between the picking head and
the actuator.

The cell collection process relies on sterile water as non-expandable system fluid between the
pumps and the picking pins. The system fluid is fed in from a detachable wash bottle and the
waste fluid is voided directly to a detachable waste bottle. The system fluid is also used to
purge out the picking pins between each cycle of picking. See Cleaning the Picking Pins on
page 89.

Note: To separate the sample from the system fluid, at the tip of the picking pins, is a
small amount of air, default 2Rl, drawn in from the sterile interior immediately before
sample collection.

These tubes can be cleaned along with the picking head.

Tip: Spor-Klenz Ready-To-Use Cold Sterilant (VZR #21899-864) sterilizing agent can be
used to stop fungal growth, while ethanol will not. Thoroughly flush out all Spor-Klenz
sterilizing agent before using the instrument again.

CAUTION! Never clean the system fluid tubes with bleach.

Note: If you autoclave, use standard conditions: 121°C at 15 psi (103 kPa) for 20 minutes.

Cleaning the Ethanol Wash Bath

The pins are cleaned during the process in the stainless steel Ethanol Wash Bath. The wash
bath includes a nylon bristle insert. During normal use, the wash bath is filled with 70% ethanol.

Tip: When the instrument is not in use, Molecular Devices recommends that you remove
and rinse the nylon bristle insert with distilled water.

If contamination is suspected, the wash bath and nylon bristle insert can occasionally be
autoclaved using standard conditions: 121°C at 15 psi (103 kPa) for 20 minutes. Slight warping of
the nylon bristle insert after autoclaving is normal, which you can force back to straightness.

CAUTION! A severely warped block must not be used because it can damage pins and
the instrument.
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Cleaning the Source Plate Imaging Cover

You can remove the Source Plate Imaging Cover and clean it with ethanol.

Source Plate Imaging Cover Upside Down

Note: Autoclaving will discolor the cover but it will not change the functionality.

Draining the Compressor

The following procedure is for the optional DynAir DA7001CS air compressor. The compressor
collects water in the internal air tank. This water must be emptied into the externally mounted
fluid collection bottle. Draining frequency depends on instrument use:

High use - drain once a day
Low use - drain once a week

To drain the air tank:

1. Verify that the compressor pressure is 105 psi.
2. Turn off the air compressor.



Chapter 6: Maintenance and Troubleshooting

5054791 G 93

3. Slowly open the valve by turning the lever on the Drain Valve to the right about a quarter of
the way open until you hear the sound of high pressure blowing air.

4. When the sound of air stops and fluid appears in the fluid collection bottle, close the valve
by turning the lever all the way back to the left.

To empty the external fluid collection bottle:

1. Remove the fluid collection bottle from the metal holder, but leave the bottle cap lever
vertical (open) and tube attached.

2. Unscrew the fluid collection bottle cap, and dispose of the fluid as required by your lab
protocol.

3. Screw the fluid collection bottle cap back on, and return the bottle to the metal holder.



ClonePix 2 Mammalian Colony Picker User Guide

94 5054791 G

Moving and Storing the Instrument

Note: We recommend not moving the instrument after installation. If relocation is
required, standard lifting gear is adequate but only do the move with Molecular Devices
supervision.

The ClonePix 2 system has caster wheels for ease of movement.

If you use a forklift or dolly trucks to move the instrument, it must be properly balanced before
lifting.

CAUTION! Do not use any part of the exterior bodywork to lift the instrument as this can
cause irreparable damage.

The instrument must be stored and transported in temperatures within the range -13°F (-25°C) to
131°F (55°C).

Commissioning Process

The Commissioning Process must be done by Molecular Devices field service engineers.
Contact Technical Support. See Obtaining Support on page 96.

Troubleshooting

This section describes some common problems that can occur and possible solutions.

Generally, crash recovery involves some form of the following procedure:

1. An error is identified in the software or the instrument stops.
2. If the error condition is caused by a receptacle or other item, then remove the item from the

instrument.
3. Reactivate the software, generally by clicking Next.

Troubleshooting Barcodes

If you use barcodes and the instrument does not detect them correctly, try the following:

If one out of 10 plates fails to be read, check the placement of the barcode label on the
plate. This might be fixed with a small change in the plate configuration.
Add more white space at beginning or end.
Restrict numbers to a maximum of six (6) digits.
Verify that the codes meet the requirements. See Using Barcodes on page 29.

If detection is still a problem, contact Molecular Devices Technical Support. See Obtaining
Support on page 96.
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Common Problems and Possible Solutions

Machine will not turn on.

Check that main power switch is turned on and the emergency stop button is released
(pulled out).

Computer will not start.

Check that computer is powered on.

One or more of the axes will not move.

Check that the main power is turned on and the START button has been pressed.
Manually move the actuator to the middle of the bed.
Disconnect and reconnect the control cable between the computer and right side of the
instrument. A small screwdriver might be needed.
Re-start the instrument.

Interior light or UV germicidal lamp will not turn on.

Check that the bulbs are not burned out.

Picking alignment is incorrect.

Ensure that the pins are correctly aligned.
Check for any bent pins and replace as needed.

Silicon tubing becomes detached from a pin during the purge.

The pin might be blocked. Replace with a new pin.

Water is leaking from picking head or actuator.

The pin might be blocked. Replace with a new pin.

Poor picking results.

Air in the system. Purge the supply line.
Check Z height of the pin.

Not depositing.

The pin is blocked. Run the Purge option or replace the pin.
Dispense volume is too low.

No liquid flow to Wash Station.

System fluid supply bottle is empty
Check the air supply and the liquid tubes for kinks.
Check that the outputs in the configuration are correct. Contact Molecular Devices
Technical Support support.moleculardevices.com/.

Wash Station is overflowing.

Check that no kinks are in the ethanol waste tubing.
Waste bottle full and/or vacuum pump is broken.

Pins are catching on the holes of the wash station.

Datum point is not set accurately.
The pins are damaged. Replace the pins.
The pins have two O-rings. Remove one.

Water is leaking from the top of pins.

Make sure each pin is fitted with one o-ring.

http://www.moleculardevices.com/service-support
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Pins are not firing correctly.

Check that air compressor is working.
Pistons might have accumulated residue. Run Pin Fire Test for up to 1 hour.

CAUTION! Do not run Pick Run Fire Test if the pins are not firing correctly.

Illumination cover is not opening or closing correctly.

Check that the air compressor is working.

No ethanol flow to the Replenishing Ethanol Wash Bath.

Check that no kinks are in the ethanol waste tubing.
Peristaltic pump tubing has become blocked, usually after period of inactivity, and needs
clearing.

Replenishing Ethanol Wash Bath is overflowing.

Check that no kinks are in the ethanol waste tubing.
Peristaltic pump tubing has become blocked, usually after period of inactivity, and needs
clearing.

Error: One or more drivers on the machine failed to home correctly.

See Knowledge Base Answer number 20364.

Obtaining Support

Molecular Devices is a leading worldwide manufacturer and distributor of analytical
instrumentation, software, and reagents. We are committed to the quality of our products and to
fully supporting our customers with the highest level of technical service.

Our Support website—support.moleculardevices.com/—describes the support options offered
by Molecular Devices, including service plans and professional services. It also has a link to the
Molecular Devices Knowledge Base, which contains documentation, technical notes, software
upgrades, safety data sheets, and other resources. If you still need assistance, you can submit a
request to Molecular Devices Technical Support.

Please have your instrument serial number or Work Order number, and your software version
number available when you call.

WARNING! BIOHAZARD. It is your responsibility to decontaminate components of
the instrument before you return parts to Molecular Devices for repair. Molecular
Devices does not accept items that have not been decontaminated where it is
applicable to do so. If parts are returned, they must be enclosed in a sealed plastic bag
stating that the contents are safe to handle and are not contaminated.

http://mdc.custhelp.com/app/answers/detail/a_id/20364/kw/%2BMove %2Bhead
http://www.moleculardevices.com/service-support
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Generating Error Reports

When the instrument is in an error state, you can generate an error report. This report is
required when you contact Molecular Devices Technical Support.

To generate an error report:

1. Select Tools > Configuration.
2. Select System Log.
3. In the System Log list, select the most recent Log.
4. In the Event Severity section, select the Error checkbox and the Fatal checkbox.
5. To review the details, highlight the results lines.
6. To generate a report of the results listed, select Tools > Prepare Error report to display the

Error Reporting wizard.
7. Click Next.
8. Specify the location to save the error logs.
9. Send the report file to Molecular Devices Technical Support.
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Appendix A: Technical Specifications

If you use the air compressor, see the documentation that comes with the compressor for
details.

Item Description

Imaging

Software Dedicated imaging software pre-installed on a high-specification PC,

Microsoft Windows 7, 32-bit, and Windows 10 64-bit

White light imaging Trans-illumination for imaging low contrast colonies such as adherent

monolayers or small colonies in suspension

Epi-illumination for imaging colonies as they are collected

Fluorescence imaging Software-controlled switching between up to 5 excitation /emission filter

pairs (we recommend no more than 3 filters be multiplexed for optimal

performance)

Data tracking Internal barcode reader for source and destination plates enables data

tracking for each run

Camera Integrated 16-bit cooled CCD camera

Imaging speed 6-well microplate: 5 min for 2 wavelengths (standard conditions)

Resolution Standard: 28 micron

Instrumentation

Containment Fully enclosed working environment with Class 100-type, HEPA filtration

Source plate type See Plate Compatibility on page 103

Destination plate type See Plate Compatibility on page 103

Source plate capacity 10 plates

Destination plate capacity 10 plates

Picking head 8 x picking pins – each pin independently controlled

Picking pin size Diameter of picking pins is application specific –F1: suspension cells (0.4

mm), F2: adherent cells (0.7 mm)

Picking speed > 200 clones per hour

Wash bath Ethanol wash bath, automatically refilled

Picking system fluids 5 L sterile water supply, 5L waste bottle

Pin drying Proprietary halogen pin drying station

Instrument dimensions 1010 mm (width) x 900 mm (depth) x 1490 mm (height)

Instrument weight 350 kg

ClonePix 2 Mammalian Colony Picker Technical Specifications

A
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Item Description

Compressor air requirements

Air Clean, oil-free with sub-micron filtration

Minimum operating

pressure

6 bar (~90psi)

Minimum operating

volume

80 L/min

Optional air compressor

Compressor unit DynAir DA7001CS, Clean, oil-free compressor with sub-micron filtration

Dimensions 440 mm (width) x 440 mm (depth) x 613 mm (height)

Weight 84 lbs (38 kg)

Power 0.75 KW

Tank size 9 L

Pump head number 2

Rated output free air Max 5.37CFM/152L.Min

Noise level 56 ±5 dB/A

Drain Manual / buffer bottle

Regulatory approval

Compliance CE

Quality ISO9001:2008 certified

Electrical Ratings

100V 50/60 Hz, 1250W

115V 60 Hz, 1250W

230V 50 Hz, 1250W

Factory set and changed by service personnel during installation

ClonePix 2 Mammalian Colony Picker Technical Specifications (continued)
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Instrument Dimensions

Front View of the ClonePix 2 Mammalian Colony Picker

Top View
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Appendix B: Plate Compatibility

The ClonePix 2 stacker system uses plate holders and a lid lift system to transport the plate into
the correct position ready for picking and depositing.

Plate Holders

There are two types of plate holders that are designed for various plate types. The Lid Pusher at
the back of the plate holder differs between the two types. This is an important part of the plate
holder because it pushes the lid onto the lid lift.

CAUTION! If you use the wrong plate holder, the lid is not pushed onto the lid lift
correctly and result in stacker failure.

Part Number Lid Pusher Color Part Number

PLATE CARRIER ASSY (13.4 MM) Green ME004233

PLATE CARRIER ASSY (8.7MM) Blue ME004232

Plate Holders

Part Number Lid Pusher Color Lid Lifter Assembly

Greiner 6 well - #657185 Green Red

Nunc Omni - #242811 Blue Silver

Nunc – 6 Well -#140675 Green White

Source Plates

B
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Part Number Lid Pusher Color Lid Lifter Assembly

Costar 96 FB - #3300 Blue Silver

Costar 96 FB - #3595 Blue Silver

Costar 96 FB - #3596 Blue Silver

Costar 96 FB - #3598 Blue Silver

Falcon 96 FB - #353072 Blue Silver

Greiner 96 FB - #655185 Blue Silver

Matrix 96 FB - #4942 Blue Silver

Nunc 96 FB - #167008 Blue Silver

Nunc 96 FB - #143761 (Lids from 163320) Blue Silver

Destination Plates

Lid Lifter Assembly

There are three different types of Lid Lifter Assembly used in the ClonePix 2 system. These
assemblies are designed to remove the lids of specific plate types.

CAUTION! To avoid plate jams, always use the correct lid lifter assembly with the correct
plate type.
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Appendix C: Replacement Parts, Accessories, and
Consumables

Replacement Parts

Part Number Description

X4941 Additional picking head populated with eight X4961 (F1 Pins)

Note: The standard instrument comes with one picking head with F1 pins.

X4942 Additional picking head populated with eight X4962 (F2 Pins)

X4949 Additional picking head without pins

X4961 F1 – ClonePix colony picking pin, 0.40 mm diameter (Single pin)

X4962 F2 – ClonePix colony picking pin, 0.70 mm diameter (Single pin)

X1036 O Rings for picking pins (Pack of 8)

X4970 Replacement picking tubing (Pack of 8)

X4948 Picking Pin Removal Key

X4972 2L Bottle and Fittings (for either wash or waste)

X4975F 5L Feed Bottle and Fittings (for wash)

X4975W 5L Waste Bottle and Fittings

X4976 Nylon bristle ethanol bath insert

ClonePix 2 Instrument Replacement Parts

Accessories and Consumables

Part Number Description

SL4950-A01 ClonePix Remote Data Viewer Software

X4990 ClonePix filter set ex 440 em 505 (CFP)

X4992 ClonePix filter set ex 500 em 550 (YFP)

X4993 ClonePix filter set ex 530 em 590 (CloneDetect 549, Rhodamine)

X4992 ClonePix filter set ex 622 em 700 (CloneDetect 622, Cy5)

SLLG025SS Millex-LG filter unit 0.20 µm hydrophilic 25 mm ethylene oxyde sterilized

K2505 aQu Clean pin cleaning solution (1L)

K8150 CaliBeads: Fluorescent beads for ClonePix 2. 200 µm diameter. Pan-wavelength.

(100 ml)

ClonePix 2 System Optional Extras

Reagents and Media

For an up-to-date list of reagents and media, see the website at: www.moleculardevices.com.

C

http://www.moleculardevices.com/
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Appendix D: Imaging Definitions

Statistic Description Category Unit

Actual X The X co-ordinate of the center of the feature in mm Position mm

Actual Y The Y co-ordinate of the center of the feature in mm Position mm

Area The area covered by the feature (excluding 'child' features)

in square mm

Morphology mm²

Axis Ratio The ratio of the minimum and maximum radiuses of the

feature measured from 0 (very elongated) to 1 (a perfect

circle)

Morphology

Block The identifier of the block of features this feature is

associated with

General

Compactness A measure of how compact the feature is, measured from 0

(not compact) to 1 (a perfect circle)

Morphology

Deposit

Barcode

Barcode of the plate the colony has been deposited in Information

Deposit Well The well the colony has been deposited in Information

Edge Excluded Whether the colony center lies within the exclusion zone Position

Feature ID A unique identifier General

Group Group the feature is assigned to General

Image Column The column the image containing the feature is in Position

Image Row The row the image containing the feature is in Position

Intensity SD The standard deviation of the intensity of the pixels in the

feature

Intensity

Manual Group Whether the feature was manually added to its current group General

Mean Center

Intensity

The mean intensity of the nine pixels at the center of the

feature

Intensity

Mean Intensity The mean intensity of all the pixels in the feature Intensity

Median

Intensity

The median intensity of all the pixels in the feature Intensity

Perimeter The length of the perimeter of the feature in mm Morphology mm

Picked Flag to signify if the colony has been picked. Information

Pixel Area The area covered by the feature (excluding 'child' features)

in pixels

Morphology pixels

Statistics for Prime Configurations
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Statistic Description Category Unit

Pixel Perimeter The length of the perimeter of the feature in pixels Morphology pixels

Pixel Radius

Max

The maximum radius of the feature in pixels Morphology pixels

Pixel Radius

Min

The minimum radius of the feature in pixels Morphology pixels

Pixel Radius SD The radius standard deviation of the feature in pixels Morphology pixels

Pixel Total Area The total area of the feature (including 'child' features) in

pixels

Morphology pixels

Pixel X The X co-ordinate of the center of the feature in pixels

relative to the top left of the image

Position pixels

Pixel Y The Y co-ordinate of the center of the feature in pixels

relative to the top left of the image

Position pixels

Proximity The distance to the closest neighboring colony in the same

image

Morphology mm

Radius Max The maximum radius of the feature in mm Morphology mm

Radius Min The minimum radius of the feature in mm Morphology mm

Radius SD The radius standard deviation of the feature in mm Morphology mm

Saturated

Percentage

The percentage of saturated pixels in the feature Intensity %

Saturated Pixels The number of saturated pixels in the feature Intensity

Selected Whether the feature is currently selected General

Source Barcode The barcode of the plate that the feature is in Position

Source Well The well the feature is in Position

Total Area The total area of the feature (including 'child' features) in

square mm

Morphology mm²

Volume

Equivalent

The volume of a sphere having the same cross-sectional

area as the feature in cubic mm

Morphology mm³

Well Index A numerical annotation of the Source Well for graphical

presentation

Position

Statistics for Prime Configurations (continued)
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Statistic Description Category Unit

Exterior Area The area of the pixels outside the feature boundary in the

local vicinity of the feature

Morphology mm²

Exterior Mean

Intensity

The arithmetic mean intensity of all the pixels outside the

feature boundary in the local vicinity of the feature

Intensity

Exterior Geo

Mean Intensity

The geometric mean intensity of all the pixels in the feature Intensity

Exterior Median

Intensity

The median intensity of all the pixels outside the feature

boundary in the local vicinity of the feature

Intensity

Exterior Total

Intensity

The total intensity of all the pixels outside the feature

boundary in the local vicinity of the feature

Intensity

Interior Intensity

SD

The standard deviation of the intensity of the pixels in the

feature

Intensity

Interior Mean

Center Intensity

The mean intensity of the nine pixels at the center of the

feature

Intensity

Interior Mean

Intensity

The arithmetic mean intensity of all the pixels in the feature Intensity

Interior Geo Mean

Intensity

The geometric mean intensity of all the pixels in the feature Intensity

Interior Median

Intensity

The median intensity of all the pixels in the feature Intensity

Interior Total

Intensity

The total intensity of all the pixels in the feature Intensity

Normalized

Intensity

The total intensity of the feature divided by the primary

area

Intensity

Sum Total

Intensity

The sum total intensity of the feature (interior and exterior) Intensity

Statistics for Fluorophore Configurations
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Appendix E: Guide to Fluorophore Configurations

The ClonePix 2 system acquires images of fluorescing colonies and generates a range of
statistics from the images in order that the colonies can be screened to select the most ‘fit’. The
user can choose which parameters to use to meet their definition of ‘fit’ – the software does not
enforce any particular definition of what the ‘best’ colonies are.

Most users want to select either the highest expressing colonies or those that are positive for a
specific parameter. The software generates various statistics to facilitate this. This appendix
explains how these statistics are generated and provides advice on how they might be used.

Measuring Fluorescence

The ClonePix 2 software works on the principal that all colonies can be detected under white
light. All the detection algorithms in the software process the white light (Prime Probe) images to
detect colony boundaries.

There are two principal advantages to this approach:

Colonies that are not fluorescing can still be detected and considered when deciding which
colonies to select.
Knowing the boundaries of all colonies allows for a more rigorous approach to processing
the fluorescent images.

Fluorescent colonies can be divided into two types:

Those whose fluorescence is purely ‘internal’, that is, within the colony boundary as
determined from the white light image.
Those whose fluorescence is also present outside the colony boundary.

Generating statistics for the first type of fluorescent colony is straightforward because for any
given pixel in the image the pixel is either within the boundary of one colony or it is a
background pixel and can be ignored. The only complication is determining what proportion of
the intensity of the pixel is ‘real’ fluorescence and what proportion is ‘background’
fluorescence. Background fluorescence would exist even in the absence of any colonies since
fluorescence images rarely have a background of zero – pure black.

Generating statistics for the second type of fluorescent colony (those whose fluorescence is
also present outside the colony boundary) is more challenging. This is because when two or
more of these colonies are close together, their fluorescence mingles together and there is no
deterministic mechanism to accurately decide what proportion of intensity of a given pixel can
be attributed to each colony. The problem is compounded as the density of colonies increases
(that is, when there are more colonies in each plate). Also, fluorescence from the second type of
colony can affect the first type of colony, which can therefore no longer be assumed to be
independent of other colonies.

Because of this difficulty, the ClonePix 2 software does not attempt to determine what
proportion of intensity of pixels outside of colony boundaries comes from any particular colony.
Instead, all the pixels surrounding each colony are included. This results in some pixels being
included in the total for several colonies, but this is not a shortcoming.

E
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It is important to know that the ClonePix 2 system measures relative fluorescence, not absolute
fluorescence. This means that fluorescent statistics can only meaningfully be compared when
generated from the same plate or batch of identical plates at the same time. It is not necessarily
meaningful to compare fluorescent statistics between different plates imaged on different days.
This is because several things can vary that affect fluorescence, for example exposure time.
Varying the exposure time used when acquiring fluorescent images increases or decreases the
absolute values of the fluorescent statistics. However, all colonies in general get brighter or
darker so their brightness relative to each other is unaffected.

Example of Fluorescent Statistic Generation

The white light image (top) shows two colonies close together. Their approximate boundaries,
as determined by the colony detection algorithm are shown in pink.

The corresponding fluorescent image is shown (bottom) with the colony detection algorithm in
pink overlaid. Several fluorescent statistics can be generated from this directly.

Note: A background subtraction algorithm is applied to all fluorescent images before
intensity statistics are generated. This algorithm seeks to determine what level of
fluorescence there would be in the absence of any colonies, and removes this from the
image so that the intensity statistics include only ‘real’ fluorescence.

Interior Intensity Statistics

The simplest statistic is Interior Total Intensity. This is the sum of the intensities of all the pixels
of the fluorescent image within the colony boundary from the matching white light image.
Larger colonies have larger totals because they are larger. This statistic is not therefore
especially useful on its own but several other statistics are derived from it.

Interior Mean Intensity is Interior Total Intensity divided by colony area (in pixels). It is the
‘average’ brightness of all pixels within the colony, or the arithmetic mean. Since it does take
account of area, this statistic can be used to compare colonies with different areas. In fact, this is
probably the most powerful statistic (along with Interior Median Intensity) since colonies with a
high Interior Mean Intensity are overwhelmingly likely to be bright colonies – rather than faint
colonies that happen to be near a bright colony that is dispersing fluorescence into the
surrounding medium.
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Interior Geo Mean Intensity is similar to the Interior Mean Intensity but is calculated as the
geometric mean. This statistic can never be greater than the Interior Mean Intensity, since the
way it is calculated tends to reduce the influence of the largest values. Whether the geometric
mean is a ‘better’ statistic to use than the arithmetic mean depends entirely on the colonies in
question.

Interior Intensity SD (Standard Deviation) is a measure of how the intensity of pixels within a
colony boundary varies. Colonies with a low value for this statistic must have pixels that all have
a similar brightness. Conversely, those with high values have both bright pixels and faint pixels
with their colony boundaries. This statistic can be used to differentiate between colonies that
have similar Interior Mean Intensity Values.

Interior Median Intensity is the intensity of the pixel midway between the faintest pixel and the
brightest pixel within the colony boundary. This is similar to Interior Mean Intensity, but tends to
be more robust since its value is less affected by a few bright or a few faint pixels. As with
Interior Mean Intensity, colonies with a high Interior Median Intensity are likely to be bright
colonies.

Interior Mean Center Intensity is the mean intensity of the nine pixels closest to the center of
the colony (that is, the center pixel and its immediate eight neighboring pixels). Often, colonies
are brightest at their center so this statistic provides an unbiased measure of the brightness of a
colony.

Exterior Intensity Statistics Calculation

The fluorescent image is shown again with the lower colony highlighted (its interior is shaded
pink). Around the colony is a red circle, which is visualized by moving the mouse pointer over
the colony. The diameter of the red circle is derived from a combination of the Average Colony
Diameter and the Exterior Statistics Diameter Multiplier provided by the user in the Detection
tab when the image was originally processed.

In this example, the user had selected an average colony diameter of 0.4 mm and an Exterior
Statistics Diameter Multiplier of x3 (left). Therefore the red circle has a diameter of 1.2 mm. It is
important to appreciate that the size of this circle is the same for every colony in the image even
though the colonies themselves are different sizes.

The significance of the red circle is that it defines the boundary within which pixels for a given
colony are processed to generate the Exterior Intensity Statistics.
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Exterior Intensity Statistics are generated by first considering all the pixels within the red circle.
Following this, any pixels within boundary if the colony of interest are excluded (the pixels
shaded in pink). Next, all the pixels that lie within any other colonies are excluded. So in the
image on the right, all the pixels within the boundary of the second unshaded colony would be
excluded. This is because any fluorescence within the boundary of a neighboring colony is
likely to have come from the neighboring colony.

What remains are the pixels that are local to the colony of interest but not within any other
colony boundary (highlighted in green in the image). These are the pixels that are used to
generate the ‘exterior intensity’ statistics.

If the colony is larger than the Average Colony Diameter specified by the user or if the colony is
an irregular shape, it is possible that some of the pixels within the colony boundary would lie
outside the red circle. In those circumstances, the red circle is not a good approximation of the
area ‘local’ to the colony. Also it is not clear how to meaningfully compare irregular shaped
colonies with the more circular shaped colonies because it is unlikely that the ‘local’ area values
produced can be used for comparative purposes.

Neighboring colonies are treated in exactly the same way. The top colony (shaded in pink) has
been selected. Again, the red circle overlaps the lower colony. This means that many pixels are
used to generate exterior statistics for both colonies.

In this example, both colonies are fluorescing and dispersing their fluorescence into the local
medium so, for the pixels close to both colonies, it is not clear what proportion of the intensity of
each pixel is derived from which colony. The area of fluorescence around the colonies looks
uniform implying that the fluorescence from each colony is not cumulative. This suggests that
counting the intensities of the pixels twice (once from each colony) would be a reasonable
approach.
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Exterior Intensity Statistics

Exterior Area (mm2) is the area of the ‘exterior’ pixels (those shaded green). It could be used to
exclude colonies that are in crowded regions of the plate. A low value for a given colony
compared to other colonies in the image indicate that the exterior intensity statistics for that
colony might not be accurate. It is not in any way a measure of the actual size of the halo of
fluorescence for any colony.

Exterior Total Intensity is the sum of the intensities of all the ‘exterior’ pixels. If there are
neighboring colonies within the red circle, this value is lower. On its own, this statistic is not very
useful since it cannot be used comparatively with other colonies.

Exterior Mean Intensity is the Exterior Total Intensity divided by the number of pixels in the
exterior area (arithmetic mean). This statistic provides a good approximation of how bright the
area immediately surrounding a given colony is, though there is no implication that the
brightness is coming from the colony as opposed to one or more of its neighbors.

Exterior Geo Mean Intensity is similar to the Exterior Mean Intensity but is the geometric mean.
See the explanation of Interior Geo Mean Intensity for further details.

Exterior Median Intensity is the intensity of the pixel midway between the brightest and the
faintest pixel within the exterior pixels. Just as the Interior Median Intensity is more robust than
the Interior Mean Intensity, so the Exterior Median Intensity is more robust than Exterior Mean
Intensity.

Sum Total Intensity seeks to approximate the sum of the Exterior Total Intensity and Interior
Total Intensity if there were no neighboring colonies within the red circle. Instead of using the
actual Exterior Total Intensity it uses the Exterior Mean Intensity multiplied by the number of
pixels within the red circle. The calculation also excludes the pixels within the boundary of the
colony of interest but includes any pixels in neighboring colonies in the red circle. If this
calculation were not taken into account, it would not be meaningful to compare Sum Total
Intensity between colonies because the value would vary depending on the presence of
neighboring colonies.

Normalized Intensity is Sum Total Intensity divided by colony area (in pixels). The highest
secreting colonies have the highest values here but unfortunately in practice normalizing by
area biases the statistic in favor of small colonies rather than bright colonies. This is because
the interior intensity is always much brighter than the exterior intensity which decreases
exponentially from the colony boundary.
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Appendix F: ClonePix 2 Data Viewer Software

Note: The ClonePix 2 Data Viewer software is optional. Contact Molecular Devices
Technical Support to purchase.

The ClonePix 2 Data Viewer software enables you to view results generated by the ClonePix 2
instrument on a computer that is remote from the instrument.

You can either access a copy of the results files or you can access the folder on the instrument
computer using Windows folder-sharing if the two computers are networked together. The
default folder location is C:\Image archive.

Tip: Any time you install and use the ClonePix 2 Data Viewer software on a computer
that is detached from the instrument, it functions as a data viewer.

Software Prerequisites

The ClonePix 2 Data Viewer software requires the installation of Microsoft .NET™ Framework
4.5.2 or newer. Your computer might already have it installed.

To check for .NET Framework 4.5.2:

1. Go to the Control Panel and click Add/Remove Programs.
2. Look in the list for Microsoft.Net 4.5.2 or newer.

Tip: Windows 10 computers should already have Microsoft .Net 4.6 or newer
installed.

3. If Microsoft .Net 4.6 or newer is installed, continue to the next step, otherwise install it now.

Installing ClonePix 2 Data Viewer Software

After verifying that the .NET Framework 3.5 SP1 is installed, you can install the ClonePix 2 Data
Viewer software. See Software Prerequisites.

To install the software:

1. Log in to the Molecular Devices Support website, go to the ClonePix™ System Software
Download Page, and in the table, click the DataViewer > Installer link.

2. Double-click ClonePix 2 Data Viewer v.x.x.x, where x.x.x is the software version number, to
start the installation.
To start the installation, if you are using the Recovery DVD, double-click
Setup_ClonePix2_Viewer.exe.

3. Follow the on-screen instructions.

Licensing ClonePix 2 Data Viewer Software

When the ClonePix 2 Data Viewer software is installed, you must license it.

The first time that you start the ClonePix 2 Data Viewer software after completing the
installation, the software prompts you for a license.
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Using ClonePix 2 Data Viewer Software

When the ClonePix 2 Data Viewer software starts, the main process screen appears.

To view the results, locate where they are stored. On the right side of the screen, click Results
Location and browse for the location of the results. The location can be a local folder on the
computer, a CD-ROM or DVD, or, if the two computers are networked together, it can be a
shared folder on the instrument computer.

After you select the location, the software catalogs all of the results and displays a list. You can
then view the results the same way as you do on the instrument computer.
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